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1 InPower™ Software License
Agreement
IMPORTANT NOTICE -- READ CAREFULLY: InPower software ("InPower") is owned by
Cummins Power Generations and is used to monitor and control power generation systems by
authorized users. This License Agreement ("License") governs the use of InPower which may
be provided via various mediums or in a downloadable form herefrom. By downloading,
installing, copying, or otherwise using InPower, You ("Licensee") agree to be bound by the
terms of this License. If you do not agree to the terms of this License, do not download, install,
copy, or otherwise use InPower in any manner or form.

RECITALS:

WHEREAS, Cummins Power Generation and Licensee desire to establish a relationship
pursuant to which Licensee will obtain certain rights from Cummins Power Generation with
respect to InPower, and Cummins Power Generation will provide certain information and
updates to Licensee, all for the mutual benefit of Cummins Power Generation and Licensee;
THEREFORE, in consideration of the above premise and the mutual covenants contained
herein, Cummins Power Generation and Licensee agree as follows:

1. License Grant and Restrictions

a. Cummins Power Generation hereby grants to Licensee a non-exclusive, non-
transferable and non-sublicensable license to use InPower to monitor and control
power generation systems manufactured or sold by Cummins Power Generation.
Each copy of InPower is specifically licensed for use in a single facility of Licensee for
its intended purpose, and it may not be sublicensed, sold, or otherwise distributed.

b. Licensee agrees to use InPower and any updates to InPower in strict accordance with
Cummins Power Generation's published service practices and/or product warranty
guidelines for the sole purpose of setting up, servicing and maintaining power
generation systems manufactured or sold by Cummins Power Generation.

c. Licensee acknowledges that Cummins Power Generation may, at its option and at no
cost to the Licensee, provide updates to InPower so that the most current version of
InPower is used to monitor and control power generation systems. Cummins Power
Generation may also offer for sale upgrades of InPower which the Licensee is under
no obligation to purchase.

d. All rights relating to InPower not specifically granted to Licensee pursuant to this
Agreement shall be retained by Cummins Power Generation.

e. Licensee acknowledges that InPower may include software that Cummins Power
Generation has obtained or licensed from a third party, and Licensee agrees that the
terms and conditions of this License shall be applicable to any such third party
software. Licensee agrees to abide by any additional or modified terms and conditions
with respect to such third party software if reasonably requested in writing by
Cummins Power Generation and/or the third party.

2. Markings

Licensee shall use its best efforts to preserve all copyright, trademark, ownership or other
notices, legends or markings on InPower as originally provided by Cummins Power
Generation. In the event InPower contains any copyright or other message imbedded
therein, Licensee shall not modify or remove such embedded message.
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3. Title

Title and full ownership rights to InPower and any updates thereto, including all copyrights
therein, shall remain with Cummins Power Generation and/or its subsidiaries. Cummins
Power Generation expressly retains all rights that it may have under U.S. or foreign laws or
international treaties relating to InPower, except for those rights expressly granted to
Licensee herein.

4. Licensee Expenses

Costs and expenses incurred by Licensee relating to any use of InPower, or any other
costs not specifically agreed upon by the parties in writing, shall be responsibility of
Licensee.

5. Payment

The Sales Price does not include any federal, state, local or other governmental taxes, or
other tariffs which may be imposed on the sale, transportation, production, storage, or
export of InPower. Any and all such taxes and costs shall be paid by Licensee and
Cummins Power Generation shall have no liability therefore.

6. Updates and Maintenance

a. Cummins Power Generation agrees to provide reasonable free support for the current
version and the latest prior version of InPower at hours, and or terms and conditions,
determined solely by Cummins Power Generation.

b. In the event of an error or defect in InPower or periodic update thereto, Cummins
Power Generation agrees to repair or remedy such errors or effects which Cummins
Power Generation deems necessary. Licensee shall, promptly upon discovery thereof,
notify Cummins Power Generation, in writing, of any errors or defects in InPower
and/or periodic update thereto. Cummins Power Generation shall use its best efforts
to remedy or repair such errors or defects, devoting reasonable resources to such
task in view of the particular business situation and customer need.

7. No Modification by Licensee

Licensee agrees not to reverse engineer, translate, reverse assemble, reverse compile,
adapt, alter, modify or change in any way InPower, or any update thereto, without the prior
written authorization of Cummins Power Generation.

8. Warranties

Cummins Power Generation warrants that InPower shall be delivered free of any rightful
claim of infringement of any copyright, trademark, trade secret or other proprietary right of
any third party, provided that prompt notice of, and control over, such claim is provided to
Cummins Power Generation by Licensee. In the event of such claim, Cummins Power
Generation may, at its sole option, defend the claim, procure for Licensee the continued
rights as described herein, modify InPower so the claim is avoided without reduced
functionality, or refund Licensee's sales price paid. Cummins Power Generation's option
shall be its sole obligation and Licensee's sole remedy in such event.

9. Warranty Disclaimer

InPower and any and all updates thereto are licensed “As Is" with the exception of the
warranties specifically provided herein. Cummins Power Generation does not claim and
does not warrant that InPower will run error free. WITH THE EXCEPTION OF THE
WARRANTIES PROVIDED HEREIN, CUMMINS POWER GENERATION DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING INPOWER, ITS
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MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE, AND
CUMMINS POWER GENERATION WILL NOT OTHERWISE BE LIABLE FOR INDIRECT,
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM LICENSEE'S USE
OF INPOWER OR FOR ANY ERROR OR DEFECT IN INPOWER. CUMMINS POWER
GENERATION'S NET LIABILITY TO LICENSEE SHALL NOT EXCEED THE TOTAL
AGGREGATE PAYMENTS BY LICENSEE TO CUMMINS POWER GENERATION WITH
RESPECT TO INPOWER.

10. Government Licensee

If Licensee is acquiring InPower as, or on behalf of, a unit of the United States
Government, the following provisions shall be applicable: The Government acknowledges
and agrees that InPower and documentation relating thereto were developed at private
expense and no part of InPower or documentation relating thereto is in the public domain.
The Government acknowledges Cummins Power Generation's representation that InPower
is “Restricted Computer Software" as that item is defined in Clause 52.227-19 of the
Department of Federal Acquisition Regulation Supplement (DFARS). The Government
agrees that:

a. If InPower is supplied to the Department of Defense (DOD), InPower is classified as
“Commercial Computer Software" and the Government is acquiring only “restricted
rights" in InPower and documentation relating thereto as that term is defined in Clause
252.227-7202-3 of the DFARS, and

b. If InPower is supplied to any unit or agency of the United States Government other
than the Department of Defense, the Government's rights in InPower and
documentation relating thereto will be defined in Clause 52.227-19(b)(2) of the FAR.

11. Confidentiality

a. Licensee hereby acknowledges that InPower and periodic updates thereto contain
valuable information belonging to Cummins Power Generation that Cummins Power
Generation considers “confidential". Consistent with the purpose of this License,
Licensee agrees to use its best efforts not to release, disclose or otherwise permit
unauthorized access to such confidential information.

b. Cummins Power Generation and Licensee agree to clearly mark written materials as
"confidential" if they are to be treated as confidential. Verbal communications that are
confidential in nature will be identified as so before, during or immediately after the
communication.

c. Licensee agrees to ensure that all individuals who are provided access to InPower
under this License are bound by this nondisclosure convenant.

12. Termination of Agreement

a. Cummins Power Generation may terminate this License at will for any reason
whatsoever, furthermore this License will automatically terminate if Licensee fails to
comply with any of the terms and conditions herein. In the event Licensee attempts to
continue to use InPower after termination of this License, Cummins Power Generation
reserves the right to restrict, limit, and otherwise void warranty claims associated with
any Cummins Power Generation product associated therwith and reserves its rights to
all other legal remedies.

b. Defensive Suspension. If Licensee commences or participates in any legal proceeding
against Cummins, then Cummins may, in its sole discretion, suspend or terminate all
license grants and any other rights provided under this License during the pendency
of such legal proceedings.
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c. In the event of termination of this License, all rights granted by this License shall
revert to Cummins Power Generation. Upon termination of this License, Licensee will
deliver to Cummins Power Generation all material furnished by Cummins Power
Generation pertaining to InPower and will also warrant that all copies thereof have
been returned to Cummins Power Generation or destroyed.

d. In the evnet of termination of this License, Licensee shall remain obligated with
respect to ther provisions of this License relating to confidentiality of information.

13. Completeness

Licensee and Cummins Power Generation agree that this License constitutes the complete
License and understanding between the parties relating to InPower and updates thereto.
This License supersedes all prior agreements, understandings, and negotiations whether
written or verbal with respect to the subject matter thereof. This License can only be
modified by a written agreement signed by both parties.

14. Export Regulations

Licensee understands that the Export Administration Regulations of the Department of
Commerce of the United States may prohibit the export of InPower to certain countries and
agrees to conform to those regulations. Licensee shall indemnify Cummins Power
Generation against any loss related to Licensee's failure to conform to those regulations.

15. Governing Law

This Agreement shall be governed by and construed in accordance with the laws of the
State of Indiana, United States of America and NOT the UNCISG. To the extent required in
order to comply with the laws and regulations of any country in which InPower is distributed
or used, the terms and conditions of this Agreement shall be construed to most nearly
effectuate the purposes of the License as set forth herein. If any provision of this License
shall be held to be unenforceable, such holding shall not affect the enforceability of any
other provision hereof.

16. Attorney's Fee's

In the event of any legal action or other proceeding that is brought about to enforce this
License, the prevailing or successful party shall be entitled to recover reasonable attorneys'
fees as well as other costs incurred in that action or proceeding in addition to any
compensation to which it may be entitled as a result.

17. Agreement Successors and Assigns

The terms and conditions of this License shall inure to the benefit of and enforceable by
Cummins Power Generation and the successors and assigns of Cummins Power
Generation's interest in this License and/or Cummins Power Generation's ownership of
InPower.
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2 Introduction

2.1 Warning
Electrical equipment and engines present hazards that can result in property damage, severe
personal injury or death. The InPower tool is for use by trained and experienced technicians
only. Refer to important Safety Instructions in the equipment's Operator and Maintenance
manuals.

WARNING: Electrical equipment and engines present hazards that can result in property
damage, severe personal injury or death. The InPower tool is for use by
trained and experienced technicians only. Refer to important Safety
Instructions in the equipment's Operator and Maintenance manuals.

2.2 InPower
InPowerTM is a Windows-based service, maintenance and diagnostic tool. This tool provides
electronic service functions including: adjustments for trims and settings, monitoring, strip chart,
data logging, viewing faults, and report capability.

NOTE: PowerCommand is a registered trademark of Cummins Inc.

The InPower tool also can be used to save a device's trims and settings to a file. The stored
settings can be viewed off-line and they can be used to configure multiple installations of the
same application controller type.

Each copy of InPower is packaged and installed separately. No more than one InPower product
can be installed on the same PC.

After successful completion of InPower version 9.5 and later versions, the tool must be
registered and set up before it can be used. The user is prompted to register the product the
first time InPower is started.

For detailed registration information, refer to the Registration and License Renewal Instruction
Sheet (A030X097).

2.2.1 Consumer Products
The service PC, running InPower, is connected to the genset control via an RS-232 serial
communications harness. Figure 1 illustrates a method used to connect a service PC to a RV
genset.

The harness is connected to the (COM) port on the PC with a DB9 connector. Some gensets
also require the use of an RS-232 to RS-485 converter. For RV installations, the other end of
the serial cable is connected to the device (for example, the generator set). For Marine
installations, the other end of the serial cable is connected with an 8-pin connector to the
generator set and an 8-pin connector to the remote connection.

901-0112 (Issue 11) 5
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FIGURE 1. TYPICAL INPOWER SERIAL CONNECTION METHOD

2.2.1.1 Interface Harness Kits for Consumer Products

TABLE 1. INTERFACE HARNESS KITS FOR CONSUMER PRODUCTS

RS-232 to RS-485Model/Device Fuel Type Required Kit Converter

HDKAx (Starting with Spec K) and Diesel 541-1374 YesHDKAW

810HQD, 1215HQD, and Diesel 541-1374 Yes1218HQD

DKHA Diesel 541-1374 Yes

HDKAx (Prior to Spec K), HDKBx, Diesel 541-1287 Noand HDKCx

HGJAA, HGJAB, HGJAC,
HCJAD, HGJAE, and HGJAF Gasoline/LPG 541-1287 No(Units with controls built in 2005
or later, up to Spec E)

HGJAA, HGJAB, HGJAD, HJGAE Gasoline/LPG 541-1374 Yes(Starting with Spec J)

HGJBB Gasoline/LPG 541-1374 Yes

MDKBH - MDKBS and MDDCx Diesel 541-1289 Yes

MGKBx (Starting with Spec C) Gasoline 541-1289 Yes

GSXX Natural Gas/Propane 541-1374 Yes

KY and MKY Gasoline/LPG 541-1287 No

MDDCx and MGKBx Gasoline or Diesel 541-1289 Yes

HQGMx Gasoline/LPG 541-1374 Yes

HJBAA NA 541-1374 Yes

MDKBx and MDDCx Diesel 541-1289 Yes

Network Interface Module (NIM) NA

PCC1301 NA 0541-1199 Yes
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RS-232 to RS-485Model/Device Fuel Type Required Kit Converter

PCC1302 NA 0541-1199 Yes

HMI211RS NA 0541-1199 Yes

RV/CM Display NA 541-1374 Yes

Marine Display NA 541-1289 Yes

All Gasoline or Diesel 541-1389 Yes

2.3 About This User's Guide
This User's Guide covers installation and operation of the InPower service tool. Last minute
software changes and corrections may be found in the InPower ReadMe file.

2.4 Supported Devices
This version of InPower supports the following devices:

· Equinox/RVInverter(HJBAA)

· MerlinLCD

· Equinox LCD(HJBAA LCD)

· Marine

· NIM

· RaptorECM(HQDECM)

· RaptorInverter

· RaptorTS(HQDTS)

· RaptorLCD(HQDLCD)

· QD1012(HDKC)

· Marquis(Marquis Premium)

· Raven Commercial

· QD55

· HWSet_A(Generic)

· HQD Inverter(HQDInverter)

· QD75(HDKAJ)

· QDSA(HDCA)

· Raven485

· Generic device (Generic485)

· APU LCD

· GENERICINV4KW

· APU(DKHA)
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· Stealth

· Stealth LCD(GSAALCD)

· APU DPF LCD(APUDPFLCD_96)

· Coyote

· Generic CommMobile(GeCommMobile)

· MARINE3LCD(MARINE3LCD)

· Razor(QG1012)

· EC30W Genset Module(EC30WGenmod)

· EC30W Display(EC30WDisplay)

· GENERICUMC3(GENERICUMC3)

· MARINE3(MARINE3)

· PCC1301

· PCC1302

· HMI211

· HMI211RS

· HMI112 Bargraph

· HMI113 Annunciator

· HMI114 Bargrap

· Aux 101

2.5 System Requirements
2.5.1 Recommended PC

The following are the recommended laptop PC specifications.

· An IBM PC or 100% compatible PC

· Recommended Operating System: Windows XP Pro, Windows Vista, Windows 7, or
Windows 8 (see details below)

· Windows Vista Capable or Windows Vista Premium Ready

TABLE 2. OPERATING SYSTEMS

Windows XP Pro Windows Vista Windows Vista Windows 8 or
Capable* Premium Ready* or windows 8.1

Windows 7**

Processor 500 MHz 800 MHz 1 GHz 1 GHz

Memory 256 MB RAM 512 MB RAM 1 GB RAM 1 gigabyte (GB) (32-
bit) or 2 GB (64-bit)

Graphics Card - DirectX 9.0 DirectX 9.0 capable Microsoft DirectX 9
and WDDM 1.0 driver graphics device with
support WDDM driver
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Windows XP Pro Windows Vista Windows Vista Windows 8 or
Capable* Premium Ready* or windows 8.1

Windows 7**

Graphics Memory - 32 MB RAM 128 MB RAM (1920 x Up to 1792 MB (1366
1200 resolution) or x 768 resolution)
512 MB+ for greater recommended
resolution such as
2560 x 1600

Hard Drive Capacity 1.5 GB 20 GB 40 GB 40 GB

Hard Drive Free - - 15 GB 15 GB
Space

Other Drives - - DVD-ROM DVD-ROM

Audio - - Audio output Audio output

* Only 32-bit Windows Vista is supported. 64-bit Windows Vista is not supported.

** Both 32-bit and 64-bit Windows 7, windows 8 and 8.1 are supported.

· Microsoft Internet Explorer version 8.0 or higher

· SVGA (1024x768) color display

· Windows compatible pointing device and 101 key enhanced keyboard

· 16X CD-ROM

· One free serial communications port

· Serial to USB communications port

· Windows compatible printer (optional)

NOTE: Please note that InPower version 7.5 and higher does not support the
Windows 95, Windows 98, Windows 2000, or Windows NT operating systems.

NOTE: Windows Vista requires the use of Adobe Acrobat 8 or newer.

2.5.2 Administrative Rights
Administrative rights are required for every installation and uninstallation.

2.6 Program Directories Installed with InPower
When InPower is installed, the InPower setup wizard creates several directories (folders) that
are used by various features in InPower. You might want to look in these directories as you use
the associated features.

The locations of these directories depend on two selections made during installation. If you do
not know what these selections were, the default locations are shown in the following table.

TABLE 3. DEFAULT LOCATIONS OF PROGRAM DIRECTORIES

Description Default Location

Folder in which InPower is installed D:\Program Files

Folder in which strip chart and monitor files are stored D:\Program Files\InPower
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The strip chart and monitor directories are created in the folder that is selected during
installation. Other directories are created in the <selected folder>\Power Generation\Shared
folder.

The installation error message shown below is displayed if a restricted path is selected.

FIGURE 2. INSTALLATION ERROR MESSAGE

InPower cannot be installed in usage-restrictive folders on Windows 7 or Windows VISTA.
Usage-restrictive folders include:

· C:\

· C:\Program Files

· C:\Windows

If any of the above paths are slected for installation, the error message displayed includes
suggested alternate paths.

If the D:\ drive, (the default location) is not available, another folder on the C drive can be used,
as long as it isn't one of those mentioned above. For example, InPower can be installed in one
of the following locations.

· C:\ETools

· C:\Cummins

· C:\InPowerPro

· C:\Service Tool

A folder with your preferred name will need to be created before installing InPower. When
installing InPower, the default installation path "D:\Program Files" is displayed as shown below.
To select a different location, click on the Browse button and navigate to the appropriate folder
and click OK.
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FIGURE 3. INSTALLATION DESTINATION LOCATION DIALOG

InPower cannot be installed on an external drive. If there is an attempt to install InPower on an
external drive a message is displayed.

FIGURE 4. MESSAGE FOR ATTEMPTED INSTALLATION ON EXTERNAL DRIVE

The user must have write access to the installation directory.

When the Tool Registration starts, the Welcome to the Tool Registration Wizard window
shows:
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FIGURE 5. WELCOME TO THE TOOL REGISTRATION WIZARD WINDOW

If the user does not have write access to the installation directory when Next is selected for
Manual or Web Registration, then a message window shows.

FIGURE 6. MESSAGE WINDOW FOR READ-ONLY ACCESS

2.6.1 Monitor
The Monitor folder contains the Target Parameter List files (.TPL). This folder will contain one or
more .TPL files. These files support the InPower software. The user will not need to view or
access any of these files.

2.6.2 Strip Chart
The Strip Chart folder contains one or more strip chart parameter listing files (.TPL).

The files contain chart design parameters, the user will not need to view or access these files.
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2.6.3 Data
The two Data folders contain data files. These files support the InPower software. The user will
not need to view or access any of these files.

2.6.4 Captured Files
The Captured Files folder stores extracted (captured) device information. Initially this folder will
not contain any files. Files are created when the user chooses to Capture to File from a
connected device (Device menu). The user names the file and InPower appends a .CAP
extension.

Captured files are read-only files. You can connect to, and view these files, but you cannot
modify the file contents. Captured files can be copied (written) to a connected device, as long as
the captured file is from the same device type.

Example: The Captured file is from a Genset controller, this file can be written to another
(connected) Genset controller. This file cannot be written to a G-Drive controller.

2.6.5 Simulator
The Simulator folder contains Captured (.CAP) files that are used to simulate a connected
device. The files are read only; however, the user can simulate editing (the changes are not
actually written to the file). The Simulator feature does not allow for simulating Edit-Save
Adjustments operations.

2.7 Start Menu Group Shortcuts
InPower installs Start-Menu shortcuts for the InPower applications. Clicking on any one of these
shortcuts will launch the selected application.

FIGURE 7. START MENU GROUP SHORTCUTS
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2.7.1 Readme File
When InPower is installed, a Readme file is copied to the Power Generation group. This file
contains last minute instructions for using InPower. Open and review these instructions after the
initial software installation.

2.8 User Interface
The InPower software operates in the Windows graphical environment and is compatible with
Windows. You can access the system like any other Windows application. If you are unfamiliar
with Windows, or have questions, refer to the Microsoft Windows User's Guide for your specific
operating system, or click on Help, from the Windows Start menu, to view the Windows Help
Topics.

All system commands are accessible by mouse and keyboard. Frequently used commands
have keyboard shortcuts and tool bar access.

InPower uses the Windows Explorer tree hierarchy for navigating a connected file or device
(referred to as Device Explorer, in InPower).

The tool's main window displays a Menu Bar and a Toolbar for access to the tool's functions.
Only commands applicable to the current active window are enabled, all other commands from
the Menu Bar or Toolbar are grayed out.

2.9 How to Get Service
If you are having a problem with the software, follow these steps.

1. Write down what you can about the problem.

2. Determine whether or not the problem can be repeated.

3. Write down the software version. (This can be found in the Help-About window.)

4. Contact your distributor.

Distributors should contact Cummins Power Generation using standard channels.

2.10 Notification of Tool Expiration
A tool expiry notification message is displayed to inform InPower users that their license is
about to expire. The message, such as "InPower Pro will exire on Mmmm dd, yyy," is
automatically generated by the InPower software. The message snoozes, based upon the
frequency set up by the user. When displayed, users should prepare for upgrading the
subscription.
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FIGURE 8. TOOL EXPIRY NOTIFICATION MESSAGE

FIGURE 9. TOOL EXPIRY NOTIFICATION MESSAGE - 15 TO 30 DAYS

FIGURE 10. TOOL EXPIRY NOTIFICATION MESSAGE - 15 OR FEWER DAYS
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NOTE: This expiry notification is mainly intended for non-Cummins users because
they need to renew the InPower software license. All registered Cummins
users will automatically be upgraded to a new release of InPower by SCCM.
Any new Cummins users should request InPower from the Software Shelf.
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3 Setup
The Setup dialog allows the installer, or System Administrator, to set user preferences and
make changes to both Sites and Devices.

NOTE: If you attempt to access the Setup program while InPower is running, the
message “Initialization mode failed" is displayed. Make sure InPower is not
running before accessing the Setup program.

3.1 General Setup
The Setup feature can be accessed from the Start menu (Start -> All Programs -> Power
Generation -> Setup).

Four Setup tabs are displayed; the Unit of Measurement tab is the default tab selection. To
select another tab, click on the desired tab. When the Site Setup tab is selected, clicking on an
item from the Site List will add a button, named Device Setup.

The Communications tab is used in genset applications to configure the service PC for remote
communications.

If you need to set up another COM port, refer to Create Site.

3.2 Unit of Measurement
This feature allows selection of a list of pre-defined units of measure, based on their region or
country. InPower will convert and display values according to the units of measure selected
from the System Of Measurement drop down list.

Users can create their own list by entering a name in the System of Measurement dialog. To
customize a setup, select individual Unit Descriptions, by Unit Type, from the drop down lists.
Click on the Apply button to save the changes.

901-0112 (Issue 11) 17



3. Setup 11-2013

FIGURE 11. SETUP DIALOG - UNIT OF MEASURE

3.3 User Setup - System Administration
The System Administration feature (User Setup) allows a person using the Windows logon (with
System Administrator privileges) to establish a user profile for each user on the system. After
the initial setup, only the System Administrator will have access to the User Setup dialog.

NOTE: By default, the user will be set up as system administrator the first time they
launch the program. After this intial launch, the user will have the ability to
change this setting to different access levels if desired.

Three access levels are available as follows:

Read Only: User can connect to a device and read all parameter settings, fault information and
history records.

Read/Write: User has full use of all InPower features, including making adjustments.

Administrator: Administrator has full use all InPower features and the ability to establish and
maintain user privileges for all users on this PC.

3.4 Capture File Options
The User Setup dialog allows the user to set their preference to either automatically create a
capture file each time they connect to a device or to be prompted before creating a capture file.
Click inside the checkbox next to the desired setting then click on the OK button. See Figure
12.
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FIGURE 12. USER SETUP

3.5 Site Setup
The Site Setup dialog allows the user to Add, Remove or edit either a port or a file (Figure
13).
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FIGURE 13. SITE SETUP PAGE OF BRAVO SETUP

To add a file or port, click on the Add button. The Create Site dialog is displayed. For more
information, see Section 3.6 on page 21.

To remove an item from the Site List, select the item and click on the Remove button. A popup
will be displayed to prompt you to continue (Yes) or cancel this operation (No) (Figure 14).
Click on the Yes button to remove the item, or click on the No button to cancel the removal.

FIGURE 14. REMOVE DEVICE DIALOG
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Selecting a site from the Site List enables the edit feature, allowing modifications to some item
properties. When a file is selected, the file location (path) is displayed. This feature allows the
user to edit the file location.

When a site is selected, the sites protocol and COM port can be edited. Also the Device Setup
button is enabled. This feature allows the user to add or remove devices.

Use the Apply button to save the data in the current dialog box to the InPower settings. Use the
Cancel button to close the Site Setup dialog without saving any changes made during this
session. Use the OK button to accept the existing settings. The Help button is used to access
help regarding the Site Setup dialog.

COM ports can be added or changed by clicking on Click here to view all available COM
ports on the Site Setup dialog. When the List of COM Port dialog is displayed, select a port
from the available list and click OK.

FIGURE 15. COM PORT LIST

3.6 Create Site
When the user selects the Add button, the Create Site dialog appears (Figure 16). This dialog
allows the user to select a Site Type, Site ID, Protocol, Location, and Name (or Device Type
and Path for files).

NOTE: All consumer devices will support generic device connections only. To create
a site as a 'consumer device' use the 'add site' menu provided in the 'Tools'
setup. Existing sites that were created previously will continue to be
supported.

Use each of the dialog fields as follows:
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Site Type - Use Physical for devices, File_A for capture files, or Network for connection to
multiple devices. Network sites are available only if the RS-485 adapter is used to connect to
the genset. A Physical connection connects to all devices and is the recommended site type for
basic tool operation.

NOTE: Initial and Update Calibration features are disabled when the Site Type =
Network.

Site ID - Typically use the name of the COM port for devices and the file name type (such as
Capture File) for files.

Protocol - Select goal as the protocol for all devices and Capture for files.

Location - Use Local.

COM Port/Path: - Enter the COM port for devices and the directory path for files. You can use
the link above it to look for available COM ports.

NOTE: To use COM3 or COM4 with InPower, use the following example to create
them and to add them to the Site List.

FIGURE 16. CREATE SITE DIALOG

The following example describes how to add a new COM port.

Example: To add a COM3 port, click on the Add button in the Site Setup dialog. Select
Physical from the Site Type drop-down list. Enter the Site ID.: COM3 and select the Protocol:
goal. Next enter Location: Local and the COM Port: 3. When finished click the OK button to
save the entries. The new port will be added to the Site List.

Once the port is established, you can setup a device for the port (Device Setup is covered on
the following page).
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For this example, Select COM3 in the Site List, click on the Device Setup button. Click on the
Add button to add a device for COM3. Enter the following information in the Create Device
dialog (Figure 19): Device ID: COM3, Device Name: COM3, Device Type: select pcf_dvc
from the drop-down list. Click on the OK button to enter the information.

When the OK button is selected, the new site is added to the Site List in the Site Setup dialog
and the message “Default device has been added to this site. Please click <Device Setup>
button to modify default settings" is displayed (Figure 17). Click OK to complete the setup.

FIGURE 17. MESSAGE DISPLAY AFTER ADDING SITE IN BRAVO SETUP

FIGURE 18. DEVICE SETUP DIALOG

3.7 Device Setup
The Device Setup dialog allows the user to Add, Remove, or edit a device (Figure 18).

Selecting a device from the Device List allows the user to edit the Device Name and Type.
The dialog also displays the Site Name, that the Device is associated with.

Selecting the Add button displays the Create Device dialog (Figure 19). This dialog allows the
user to enter a new Device ID., Device Name and allows the user to select a Device Type
from a drop-down list.
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FIGURE 19. CREATE DEVICE DIALOG

Use each of the dialog fields as follows:

Device ID - Enter a name to identify the device.

Device Name - Use a generic term to describe the device (such as GCS).

Device Type - Select pcf_dvc (dominion based control system).

3.8 Add a Site from the InPower ONAN Main Window
A user can add a site from the InPower ONAN Main Window.

1. In the InPower ONAN Main Window, select Add Site from the Port menu (figure xx). The
Add Site dialog window shows (Figure xx).

2. In the Add Site dialog window, select the Product, type the Site ID, and select the Com
port. You can use the link above the COM/Telephone field to find available COM ports.

FIGURE 20. ADD SITE FROM INPOWER ONAN MAIN MENU
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FIGURE 21. ADD SITE DIALOG WINDOW

3.9 Monnet InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group.

In this example a new site will be created specifically for connecting to a MONNet (PCCnet)
network.

FIGURE 22. MONNET SITE SETUP

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the MONNet. Select the Site Type Network, from the drop-down
list. Select Network Type MONNet. Enter a Site ID. Enter 1 (or the desired com port) for the
COM Port. Click on the OK button to create the new site (Figure 22).
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Select the MONNet site from the site list and note that the Device Setup feature is disabled
(Figure 23). When InPower is connected to a MONNet site it automatically checks the number
of devices that are connected to the site and shows the active devices under the site.

FIGURE 23. MONNET DEVICE SETUP

A typical connection for a MONNet application is shown in Figure 24.

FIGURE 24. MONNET CONNECTION

26 901-0112 (Issue 11)



4 InPower Basics
This section describes InPower's user interface features.

4.1 How to Start InPower
1. Open the Start menu.

2. Click All Programs > Power Generation > InPower ONAN > InPower ONAN.

Attempting to launch InPower or the Bravo Setup when one of these programs is already
running will result in an error message.

· If an attempt is made to run a second instance of Bravo Setup (Start > All Programs >
Power Generation > Setup), the following message is displayed.

FIGURE 25. BRAVO SETUP MESSAGE FOR WHEN BRAVO SETUP IS ALREADY IN USE

· If InPower is launched and then an attempt is made to launch Bravo Setup (Start > All
Programs > Power Generation > Setup while InPower is still running), the following
message is displayed.

FIGURE 26. INPOWER IS RUNNING MESSAGE FOR WHEN ATTEMPTING TO USE BRAVO SETUP

· If the Bravo Setup is launched and then an attempt to launch InPower is made while Bravo
Setup is still running, the following message is displayed.
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FIGURE 27. BRAVO SETUP IS RUNNING MESSAGE FOR WHEN ATTEMPTING TO USE INPOWER

4.2 The Main Window
The main window, named Device Explorer, includes the Menu Bar, the Toolbar, the Status
Bar, and the left and right window panes.

The Menu Bar contains the groups of commands that are used to access tool functions and
features. A list of menu options is available under each main menu entry.

The InPower Menu Bar expands to display additional menu features when InPower is
connected to a device or a file.

When a Menu Bar command is grayed (dimmed), the command is not available. You may need
to select another action (such as connecting to a port or device) before the grayed command
will be displayed in black type—indicating that the feature is available.

· To display the list of options under a menu entry, move the mouse pointer to the menu
name and click on the mouse button. (Clicking refers to using the mouse select button,
typically the left button.)

· To select an option from a menu list, move the mouse pointer to the option name and click
on it.

The Toolbar provides direct graphical interface shortcuts to some of the more frequently used
menu options. Buttons on the Toolbar represent frequently used tool functions.

When a Toolbar button is grayed (dimmed), the shortcut to that command is not available. You
may need to select another action (such as connecting to a device or file) before the grayed
command will be displayed in color (or black type)—indicating that it is available.

Placing the mouse pointer on a Toolbar button, the Status Bar describes the function of the
button. The Status Bar also shows a description of operations as they occur.

The left window pane works like Windows Explorer to navigate the directory tree. The right
window pane displays the contents (or screens) for the item selected in the left window pane.
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4.2.1 Main Window Example

FIGURE 28. MAIN WINDOW

FIGURE 29. STATUS BAR DETAILS

4.3 Menu Descriptions
This section provides a brief description of the functions performed by each of the InPower
menu commands. Some of the menus are not displayed until the tool is connected to a Port
(COM port or .CAP file).

Several of the menu features have Toolbar shortcuts and some features can be enabled simply
by double clicking on the item from the directory tree in the left window.
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4.3.1 Port
The Port menu allows the user to Connect to and Disconnect from a port. InPower uses the
term Port to refer to either a COM Port or a .CAP(ture) File, including Simulator files. The Port
menu also allows the user to Add a local or remote Site, find InCAL calibrations, and it has an
Exit selection for exiting InPower.

In order to connect to a COM port, the PC must be physically connected to a device via a serial
communications null-modem cable.

COM port error messages are displayed at the following times:

· In Bravo Setup when the user selects add site

· In Bravo Setup when the user selects apply

· In Bravo Setup when the user selects another site

· When the user closes bravo setup

· In Engineering Tool when the user selects add site

· In InPower Tool when the user selects add site.

The following shows an example error message:

FIGURE 30. MESSAGE DISPLAYED FOR COM PORT

4.3.2 Device
The Device menu is used to Connect to, and Disconnect from, a device, and for performing
read and write functions with a connected device. InPower uses the term device when referring
to a controller such as the generator set control.

Use InPower to change a device's trims and settings, and then use the Device menu to Save
Adjustments. The device's parameters can be Captured (saved) to a File.

The Device Menu can also be used to Clear Faults (inactive faults only) and to Prepare CSV
file with All Selected Features of the device's settings.

When the InPower service tool is connected to a device, three new features are added to the
Device menu; Initial Calibration, Update Calibration, and Update Features.
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4.3.3 Edit
The Edit menu works within the directory of the connected device to Find a specified string of
data. The Edit menu can also be used to Copy and Paste selected data.

4.3.4 Utilities
The Utilities menu is used to download simulator files from an InCal CD. When Utilities ->
Universal Simulator Download is selected, a pop-up menu is displayed allowing you to set the
COM port and baud rate. If the InCal CD is inserted in your local drive, you can navigate to the
simulator file(s) you wish to download and then click on Download.

4.3.5 View
The View menu is used to view data from the connected device in a Monitor display or Strip
Chart display. The View menu can also be used to access the FIS Fault Tree Main Window,
view faults and refresh (update) all of the parameters displayed in the Value field.

4.3.6 Help
The Help menu commands are used to find online information about using InPower and
Windows. Help is also used to display Service and Support information and to obtain InPower
product and version information. A separate Help file contains information on consumer device
fault codes for marine and RV products. The menu also allows the user to launch the
registration program.

4.4 User Interface
Frequently used commands have keyboard shortcuts and toolbar access. Only commands
applicable to the current active window are enabled. All other commands are grayed out.

4.4.1 Keyboard Access
InPower uses standard Windows keyboard conventions.

The underlined letter indicates the keyboard selection for a given menu option. For example, to
select the Port menu, press and hold the “Alt" key and type a “P" (Alt P).

Once the menu is open, type just the underlined letter to select a specific menu item. For
example, once the Port menu is open, type a (C) to select Connect.

4.4.2 Toolbar
Some frequently used commands have toolbar shortcut buttons. Each button is associated with
one or more menu items. The buttons have the same effect as the menu items.
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4.4.2.1 Toolbar Example

FIGURE 31. TOOLBAR

4.4.3 Dialog Boxes
A dialog box is a window that requires information from the user. Often, when you select a
function or menu option, the software will display a dialog box. You will then provide the
required information by selecting an item from a list, by clicking on an option button, or by
entering text. Several different dialog boxes are used with InPower.

The following rules will apply to all the dialog boxes and system messages unless specified
otherwise.

· The Cancel button allows you to close and exit a dialog box without saving any
modifications, and without executing any commands.

· The OK button allows you to save any changes made and/or execute a command and
close the dialog or message box.

All lists that the dialog boxes display are sorted alphabetically.

4.4.4 Mouse Menu Functions
In some Window views, clicking on the right mouse button will bring up a menu command
related to that Window. (Some users change the right and left mouse functions to their
preferences. The default settings for a two-button mouse are left for select and right for menu.)

Example: When viewing Faults in the Detail View, clicking on the right menu button will bring up
three choices:

· View Snapshot
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· View Fault Information

· Clear Faults

4.5 How to Terminate InPower
Should the InPower program ever hang up or crash abruptly, the Terminate InPower Application
utility can be used to close all InPower applications. After the applications are closed, InPower
can be re-launched and work can be resumed.

NOTE: This feature is not available on PCs with a Windows 2000 operating system.

To use this feature, go to Start > All Programs > Power Generation > Utilities > Terminate
InPower Application.

FIGURE 32. LAUNCHING THE TERMINATE INPOWER APPLICATION FEATURE

After the Terminate InPower Application is launched, the following message is displayed.

901-0112 (Issue 11) 33



4. InPower Basics 11-2013

FIGURE 33. TERMINATING INPOWER APPLICATIONS MESSAGE

Afer clicking Yes, all Etool applications are terminated and the following message is displayed.
Click OK.

FIGURE 34. ETOOL TERMINATION MESSAGE
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5 Genset Service
This section describes how to use InPower for making adjustments and performing tests on
commercial or consumer gensets. When the user is connected to a genset, they can also
access the Monitor, Faults, and Events Configuration features.

5.1 Consumer Genset Service
InPower performs several functions including genset service and diagnostic functions. The
Adjustment feature is used to perform service adjustments and trims.

The Test feature is used for diagnostics. Test is used to temporarily override a variety of input
and output parameters.

WARNING: Electrical shock and moving parts can cause severe personal injury or death.
Notify personnel before starting a generator set. Refer to the equipment
Operator's Manual for important safety precautions.

You must be connected to the genset in order to write adjustment trims and setting changes to
the controller, and to temporarily send test commands to the genset controller. The features
described may not apply to all control types.

5.1.1 Connecting to a Genset
Connection between the service PC and the genset is made with a special RS-232 interface
harness. If the service PC does not have a serial port, a USB-to-serial converter may be
required as well.

Figure 36 and Figure 37 show two types of connections to a genset in a recreational vehicle.
Figure 38 shows how to connect to a marine genset. The interface harness from the service PC
can be connected to the engine harness at the remote connector. Disconnect remote
connections and connect the tools. Interface harnesses are available for all connection
methods.
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FIGURE 35. DEVICE EXPLORER - TYPICAL GENSET FEATURES

FIGURE 36. INPOWER SERIAL CONNECTION FOR HDKCX, HDKAX (PRIOR TO SPEC K, AND
HDKBX DIESEL GENSETS AND HGJAA, HCJAD, HGJAB, HGJAC, HGJAE, HGJAF (UNITS WITH

CONTROLS BUILT IN 2001 OR LATER), KY, AND MKY GASOLINE/LPG GENSETS
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FIGURE 37. INPOWER SERIAL CONNECTION FOR HDKAX (STARTING WITH SPEC K), DKHA,
HDKAW, 810HQD, 1215HQD, AND 1218HQD DIESEL GENSETS, HQGMX GASOLINE/LPG GENSETS,

GSAAX NATURAL GAS/PROPANE GENSETS, AND HJBAAX AND RV/CM DISPLAYS

FIGURE 38. SHOWS HOW TO CONNECT TO A MARINE GENSET. THE INTERFACE HARNESS
FROM THE SERVICE PC CAN BE CONNECTED
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5.1.2 Connecting to an HQD Inverter/Charger, Transfer Switch,
or Display and an RV Inverter and GSAA
InPower can also be used with recreational vehicles with an HQD generator to communicate
with the inverter/charger, transfer switch, or the display.

Connection between the service PC and the device is made with a special RS-232 interface
harness.

Figure 39 shows how to connect to an inverter/charger or a transfer switch. Figure 40 and
Figure 41 show how to connect to a display. The interface harness from the service PC can be
connected to the inverter/charger or transfer switch. The interface harness from the service PC
must be connected to an adapter harness that is connected to the display and a power source.
Connections to these devices require an RS-232 to RS-485 communications converter.
Interface harnesses are available for all connection methods.

NOTE: When using InPower is connected to the transfer switch to do an update or
an initial calibration, the display must either be asleep or disconnected.

FIGURE 39. INPOWER SERIAL CONNECTION FOR AN HQD INVERTER/CHARGER OR TRANSFER
SWITCH, RV INVERTER, AND GSAA
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FIGURE 40. INPOWER SERIAL CONNECTION FOR 6-PIN RV/COMMERCIAL MOBILE DISPLAYS

FIGURE 41. INPOWER SERIAL CONNECTION FOR 8-PIN RV/COMMERCIAL MOBILE DISPLAYS
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5.1.3 Connecting to Marine Devices
5.1.3.1 Programming A Marine Control

NOTE: For communicating and troubleshooting only, use a MONnet connection and
plug into the remote control. For programming using MON, refer to the wiring
diagrams.

To program a Marine control, refer to the connections shown in Figure 42.

1. If you installation includes a display or a Network Interface Module (NIM),

a. Disconnect the generator set remote control connector.

b. Connect the interface harness (P4) to the generator set remote control connector.

c. Connect the jumper (J7) to the interface harness (P2).

d. Connect the jumper (P8) to the adapter harness.

e. Install the RS-232 to RS-485 converter on the PC.

f. Connect the interface harness to the RS-232 to RS-485 converter.

2. If your installation does not include a display or a NIM, plug the interface harness into the
remote control connector.

3. Wake up the control using the display or the Start/Stop switch. Press Stop until the status
light comes on or the LCD screen shows genset data.

4. Program the control.

5. Remove the battery and reconnect the wiring to its original configuration.

40 901-0112 (Issue 11)



11-2013 5. Genset Service

FIGURE 42. INPOWER SERIAL CONNECTION FOR MARINE CONTROLS

5.1.3.2 Programming A Marine Display
To program a Marine display, refer to the connections shown in Figure 43.

1. Disconnect the adapter harness from the display.

2. Connect the jumper (J7) to the adapter harness.

3. Connect the jumper (P8) to the interface harness (P4).

4. Connect the interface harness (P2) to the digital display.

5. Install the RS-232 to RS-485 converter on the PC.

6. Wake up the control by pressing any button until the backlight is enabled on the display.

7. Connect the interface harness to the RS-232 to RS-485 converter.

8. Program the display.

9. Remove the battery and reconnect the wiring to its original configuration.
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FIGURE 43. INPOWER SERIAL CONNECTION FOR MARINE DISPLAYS

5.1.3.3 Programming A Network Interface Module (NIM)
To program a Marine NIM, refer to the connections shown in Figure 44.

1. Disconnect the generator set harness from the adapter harness.

2. Connect the jumper (J7) to the generator set harness.

3. Connect the jumper (P8) to the adapter harness.

4. Connect the interface harness (P4) to the adapter harness.

5. Connect the interface harness (P2) to the digital display.

6. Install the RS-232 to RS-485 converter on the PC.

7. Connect the interface harness to the RS-232 to RS-485 converter.
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8. Wake up the control using the display or the Start/Stop switch. Press Stop until the status
light comes on or the LCD screen shows genset data.

9. Unplug the display.

10. Program the NIM.

11. Remove the battery and reconnect the wiring to its original configuration.

NOTE: For communicating and troubleshooting only, use a MONnet connection and
plug into the remote control. For programming using MON, refer to the wiring
diagrams.

FIGURE 44. INPOWER SERIAL CONNECTION FOR PROGRAMMING A NIM

5.2 Starting InPower
Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, that is being used for the genset connection. The available COM ports are
displayed in the Device Explorer directory (left pane). Double click on the COM port (or click on
the COM port and then click on the Connect button, on the toolbar).
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If InPower has problems connecting to a site, the message shown in Figure 45 is displayed. If,
after a few seconds, the program still cannot connect to the site, the connection failure message
shown in Figure 45 is displayed. If you get this message, click on OK, make sure the selected
COM port is available, make sure the COM port is being used, verify that the RS-485 adapter is
correctly installed, make sure the genset is powered and the control is awake, check all
connections, and repeat the procedure for connecting to the COM port.

NOTE: To wake up the genset control, press and hold the Stop button on the genset
until the switch's status light is enabled.

FIGURE 45. CONNECTION PROBLEM MESSAGE

FIGURE 46. CONNECTION FAILURE MESSAGE

The InPower Device Explorer displays the features that are available for gensets in the
directory, listed under the device in the left pane. To view the genset features, make sure the
genset is powered up and the genset control is awake, double click on the site (COM1, COM2,
etc), and expand the genset directory.

When you double click on a site the first time after InPower is started, the Progress messages
shown in Figure 47 are displayed to show you that InPower is connecting to the device and
verifying parameters. When completed, a message is displayed to inform you of the location
where capture files were placed (Figure 48). Click on OK to acknowledge the message.
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FIGURE 47. DEVICE PROGRESS MESSAGES

FIGURE 48. ANNOUNCEMENT OF CAPTURE FILE LOCATION

If a connection failure message is displayed when attempting to connect to an available device,
make sure the device is turned on and check all connections.
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The following is a typical list of available features.

· Adjustments

· Events Configuration

· Faults

· Monitor

· Test

· CAN Control

· Events and Faults

NOTE: The available features vary from genset to genset.

When you are connected to a genset, the Capture File feature is enabled. This feature is used
to create a copy of the gensets existing parameter values. Always create a Capture file of the
device parameters for reference, prior to making any adjustments.

5.3 Genset Adjustments
This section describes how to make genset parameter value adjustments for trims and settings.
There are a large number of adjustable trims and settings available for gensets. Not all genset
models will have the same adjustments available. This section will cover typical adjustment
examples, to help demonstrate basic procedures for using the adjustment features.

CAUTION: Improper adjustment can cause equipment malfunction or damage. Adjustments
must be performed by trained and experienced personnel only. Refer to the
equipment's Installation and Service manuals for adjustment sequences and
procedures.

5.3.1 Adjustment Basics
To access a group of adjustments or an individual adjustment, use Device Explorer to navigate
the left pane until you reach the desired folder, and click on it. The right pane will display the
parameter(s) associated with the adjustments for that feature.

Figure 49 shows a list of parameters for the Governor - Frequency selection.

The right pane displays the Parameter description, Value, Units of measure and the Last Time
that the value was Read.

Placing the mouse pointer over a parameter will bring up an information popup box. The popup
provides a brief description of how the parameter value is used.

NOTE: Some values may require that the genset is running or stopped before they
can be edited. Refer to the parameter's information pop-up for details.
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FIGURE 49. TYPICAL PARAMETER INFORMATION

5.3.2 Adjustment Features
The groups and the contents of the Adjustment features can vary by genset model, control
software version, and InPower version.

The Adjustments directory for a typical genset contains the following groups (folders) of
Adjustment options:

AC Measurement Calibration: This group contains Current, Voltage and Power Factor
measurement parameters for the graphical display. Also contained in this group is the
calibration for Voltage Measurement for Regulation.

Alternator Protection: Contains adjustments for Over and Under Frequency, High and Low AC
Voltage, and related time delay settings.

Automatic Voltage Regulator: Contains adjustments for the Voltage Adjust trim for the
nominal voltage offset, overall AVR gain adjust, and the V/Hz rolloff table.

Engine Protection Adjustments: Engine protection settings for high and low temperature,
pressure settings, and related time delays.

Features: This group contains several genset setup and feature settings. For example, the
Exercise Setup parameter allows the user to set the genset exercise duration, in hours.

Genset Power Ratings: Contains adjustments for setting up the application information such as
Standby or Prime Power, Delta or Wye alternator connection, KVA rating, line-to-line voltage
and generator connection for single or three phase.

Governor: This group contains Governor adjustments for Frequency settings, Gain and Droop
settings, and Idle and Ramping.

LONWORKS: This group contains network settings, Controller Identification, modem Dialout
Setup, network Fault Setup and Network Setup.

Paralleling: This group contains parameters for Breaker Interface, Bus Voltage Setup, Load
Share Setup, Paralleling Mode, Protection, and Synchronizing.
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Passwords: This group contains three features that are used for password administration.

The Change Passwords feature is used to establish initial passwords and to change existing
passwords.

Passwords must be 5 to 8 characters in length. They may consist of any combination of alpha
or numeric characters. Do not use special characters.

The Clear Passwords feature allows users, with a password, to clear the password. This is
typically used if you wish to permanently remove the password. If you want to change an
existing password, use the Change Passwords feature.

The Enter Passwords feature is used to gain access to password protected parameters.
Entering the password allows the user to write changes to password protected parameters.

There are two predefined groups of parameters that can be protected by passwords, these are
named User and Application. When a password is established for either of these groups,
access becomes password protected. Users can view password protected parameters, but they
cannot write changes to them without Entering the password first.

The Site Password feature is used to provide password protection when accessing a device
from a remote (dial-in) location. This feature can also be used to administer an existing site
password.

Refer to the examples of changing, entering and clearing passwords, in this section.

Reset History Counters: Allows the user to reset the history records for Fuel, Power, and
Starts and Runs in a genset control.

Starting: Contains parameters for setting cranking time settings and attempts, and for Start
Time Delay.

Switch Setup: Contains a group of miscellaneous switch parameters for monitoring and for
setting switches to a specific state. An example of switch some states are: Enable or Disabled,
Started or Stopped, On or Off, Active Open or Active Closed, etc., The settings depends on the
type switch selected.

Many of these features contain sub menus of additional adjustment features. Use Device
Explorer to expand each of these categories to view the sub-menu of adjustments.

FIGURE 50. TYPICAL ADJUSTMENT FEATURES
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5.3.3 Making Adjustments
Located to the left of each parameter is an icon that indicates if the parameter can be adjusted
or if it is for monitoring (refer to Figure 50).

The screwdriver icon is used for trims and settings that can be written permanently to the device
(read and write). When the cursor is placed over a parameter that can be adjust, the range for
the parameter is displayed (Figure 51). The magnifying glass indicates that the parameter value
is being monitored (read only). The switch icon is used to display settings that can be
temporarily written to a device. The wrench icon represents factory settings that are not
adjustable with InPower.

FIGURE 51. PARAMETER RANGE

NOTE: The value being monitored will not automatically update. The user can
double click on the parameter to update the value field or click on the
Refresh button, on the toolbar.

Each parameter displays the current value and the units of measure for that value. Review this
information before making adjustments. Parameter value trims and settings are displayed.
Trims are numeric values that are entered directly into the Value cell. Settings are selected
from drop down lists, and they consist of several types of values such as On/Off and
Enable/Disable.

To change a parameter value, double click inside the Value cell of the parameter that you wish
to change. The current value will be highlighted, if there are only a few choices, a drop-down
arrow will be displayed next to the Value.

If an arrow is displayed, click on the arrow to view a drop-down list of the available settings.
Click on the desired setting, and it will be entered into the Value cell.

If you do not see an arrow, begin typing the new value, the new value entry will overwrite the
current value. If the value entered is above or below the range of acceptable values, an error
message dialog box will be displayed (Figure 52). Review the information in the dialog box to
see the value limits, before clicking OK, to close the error message dialog box.

FIGURE 52. ADJUSTMENT ERROR

5.3.4 Saving Adjustments
Edit Mode: When selected, a parameter value remains in the edit mode (to change a numeric
value or select from a drop-down list). When finished making adjustments, press the enter key
or click on another parameter value to exit the edit mode.
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Saving Adjustments: Adjustments are written to the device as they are entered. To make
these changes permanent, click on the Save Trims button, on the toolbar (floppy disc) or click
on the Device menu and select Save Adjustments. Changes in adjustments will immediately
alter the device's performance.

After the Save Adjustments button is selected, a Save Adjustments dialog is displayed. This
feature allows you to view and confirm your changes by clicking on Save. You can make final
edits within this dialog by double clicking inside the New Value box and entering a new
parameter value or you can reset all of your changes by clicking on the Cancel button.

Saved adjustments are written to the Audit Trail in the Monitor feature. Refer to the Audit Trail
to review the record of adjustment changes.

If the user loses connection with the device before saving an adjustment, the change will not be
saved.

5.4 Test
The Test feature is a diagnostic tool that is used to perform internal self-checks on the device
(Self Test). Use InPower to verify inputs and outputs of the device, and test device protection
functions (like Overspeed).

After changing a Test parameter, the user can observe or measure the results of the changes.

NOTE: There are two types of Test Commands: maintained inputs and momentary
inputs. When a maintained input is set to active, the input will remain active.
The InPower user MUST set the input back to inactive, when they are finished
with the test or before leaving the site, otherwise the command will remain
active.

Momentary inputs automatically change state to inactive after one second.

Maintained inputs generally have the screwdriver icon next to the parameter name, and
momentary inputs have the switch icon next to the parameter name.

This section describes each group of tests listed in the Test directory. The Self Test feature can
be used as a quick check to determine if the genset control is responding, by sending control
inputs that should activate the control outputs. The other Tests are used for performing more
specific test functions.

The Test parameter values are adjustable (Figure 53). Some parameters have a numeric value
that can be changed while others have values that can be selected from a drop-down list.

5.4.1 Consumer Gensets
The Test directory may contain the following groups (folders) of Test options for consumer
gensets:

· Starter Override Request

· Starter Override Command

· Starter Override Status

· Glow Plugs Override Request

· Glow Plugs Override Command

· Glow Plugs Override Status
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· Fuel Pump Override Request

· Fuel Pump Override Command

· Fuel Pump Override Status

· Run Output Override Request

· Run Output Override Command

· Run Override Status

· Status Light Override Request

· Status Light Override Command

· Status Light Override Status

· Power Latch Override Request

· Power Latch Override Command

· Power Latch Override Status

· Inverter Enable Override Request

· Inverter Enable Override Command

· Inverter Enable Output Status

· Governor Output Override Request

· Governor Output Override Command (in percent)

· Governor Output Override Status

· Set High Idle

5.4.2 Override Requests
This test option allows you to enable or disable an override for each of the eight devices.

5.4.3 Override Commands
For the starter, glow plugs, fuel pump, run output, status light, power latch, and inverter, this test
option allows you to set the override command to On or Off. For the governor output, this test
option allows you to set the range from 0 to 100%.

Pressing the Stop button disables any override. Overrides are active for 60 seconds, and then
are disabled.

WARNING: Overriding genset command may result in damage to the genset. Only
trained and experienced personnel should override genset commands.

5.4.4 Override Status
For the starter, glow plugs, fuel pump, run output, status light, power latch, and inverter, this test
option allows you to see the current state of the override status. For the governor output, this
test option allows you to vary the governor output from 0 to 100%.
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5.4.5 Set High Idle
While the default value is Normal, this variable can be used to set a mechanical High Idle Stop
by setting the value to “Set High Idle."

FIGURE 53. ADJUSTABLE TEST PARAMETERS

5.4.6 Inputs
When inputs are externally activated, the Inputs feature can be used to monitor the inputs. The
actual inputs can be measured with a multimeter and the results can be compared.

Example: To test the Oil Pressure Input, check the genset wiring diagram for the location of
the oil pressure sender input. In this example the input is on connector 05 between pins 22 (+)
and 23 (gnd). Remove the connector and insert the service breakout box. Check for voltage
between pins 22 and 23.

If no voltage is present, check the harness and the sensor. If voltage is measured, and InPower
and the Operator panel display no input, the connections to the control, or the control are
suspect.

Figure 54 shows the results when an input voltage is present, in this example the oil pressure
(approximately 26 psi) is displayed in InPower, and should also be displayed in the Operator
Panel display.
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FIGURE 54. TEST - INPUTS - OIL PRESSURE

5.4.7 Manual Operation
This feature allows the user to perform genset operations including exercising the genset,
stopping the genset and bypassing the warm-up period (used if the genset is already warmed
up).

Example: In this example, InPower is used to initiate a Manual Run Command. Make sure that
the Run/Off/Auto switch, on the genset control panel, is set to Auto. Double click on the Manual
Run Command Value cell, and a drop-down list arrow is displayed (refer to Figure 55). Click on
the drop-down arrow and click on Run. To initiate the Manual Run Command, click on the
Save Trims button, on the toolbar. To end the Run command double click on the Value cell
again, click on the drop-down arrow and click on Stop, then click on the Save Trims button, on
the toolbar.

5.4.8 Outputs
The Outputs feature allows the user to activate relay drivers without running the genset. This
feature can be used to test the relays and wiring, or measure the relay driver output with a
voltmeter.

Example: In this example, InPower is used to enable the Load Dump Override Command
(refer to Figure 56). Make sure that the Load Dump parameter is set to Driver On. (If it is not,
change it with the Load Dump Override Command parameter, and save that parameter
setting.)
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Double click on the Load Dump Override Enable Value cell. A drop-down list arrow is
displayed, click on the drop-down arrow and click on Enabled. To temporarily write this output
to the Load Dump Override Relay, click on the Save Trims button, on the toolbar. The
override can be disabled by selecting Disabled in the Value cell, then click on the Save Trims
button, on the toolbar.

FIGURE 55. MANUAL OPERATION - MANUAL RUN COMMAND

FIGURE 56. OUTPUTS - CUST. SUPPL. WIRING - LOAD DUMP

5.4.9 Fault Simulation
This feature allows the user to test alternator protection and engine protection devices by
temporarily overriding the sensor inputs and verifying that the engine shuts down. There are a
large number of protection features that can be checked.

Example: In this example, InPower is used to test an engine protection feature (Figure 57).

The user can make a check of the current engine protection settings for low oil pressure. Double
clicking on the XY Table Value cell for the LOP Warning Threshold Table. Review the oil
pressure Vs. RPM chart to see where the warning threshold points are set. Note the warning
levels, and then close the XY table.
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Double click on the Oil Pressure Override Command Value cell and enter a voltage amount
that will be low enough to trigger the warning (or leave the setting at the default 0 volts).

Double click on the Value cell for the Low Oil Pressure Override Enable. A drop-down list
arrow is displayed, click on the drop-down arrow and click on Enabled. To temporarily write this
output to the device, click on the Save Trims button on the toolbar.

The Alarm popup will display the active warning (Figure 57).

FIGURE 57. TEST - ENGINE PROTECTION -OIL PRESSURE TEST

5.4.10 Self Test
InPower has built in tests that can be used for diagnostics. The default setting is the Test Abort
value (not in test mode) setting. Figure 58 shows the Self Test options. Double click on the
Value cell, then click on the arrow to display the drop-down list of settings.

The Self Test feature has two Built In Tests (BIT Command). The first test, named Test
Stationary, is used to check all sensors and output relays by activating control outputs. The
user can then monitor inputs, if fault conditions occur, the event handler will popup to display
faults.

WARNING: Notify personnel before using the Self Test Feature to crank the engine.
Severe personal injury or death can result. See the equipment Operator's
Manual for important safety precautions.

The second test, named Test Cranking, sends a start cranking signal to the engine to test the
magnetic pick-up (MPU) speed sensors, starter relay and battery level.

The Test Abort setting is the default setting, indicating that a Self Test is not in process. When
you are finished with a Self Test, or to end a test, return the BIT Command Value to Test
Abort.
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5.4.11 Speed Override
The speed override options are used to override the normal governor reference input to the
control. The Speed Reference Override feature can be Enabled to override the governor
reference input in order to operate the engine at another speed, for diagnostics purposes.

FIGURE 58. SELF TEST - TEST -BIT COMMAND

5.4.12 Single Cylinder Cutout Test
InPower can used to cutout fueling to one cylinder at a time. This test can be used to help
isolate a cylinder with fueling or combustion problems.

Example: InPower is used to perform a single cylinder cutout test (Figure 59). This test is used
in genset applications that use QSX-15 series engines (part of DFE series).

CAUTION: Do not cutout fueling to more than one cylinder at a time or engine damage can
result. Always change the Cylinder Cut Out Test Enable to Disabled, when finished
testing. Follow these steps carefully and refer to the equipment Operator's Manual
for Important Safety Precautions.

Connect the service PC to the genset. Start the genset and operate it at rated speed with no
load.

Open the Test\Fuel System Test parameter group. Make sure each of the six cylinder
parameter values are set at 1 (enabled).

Double click on the Cylinder Cut Out Test Enable parameter and select Enabled.

Double click on the desired cylinder for testing, in this example: Cylinder #1 Injector Fueling.
Enter 0 (disabled). Use the Save button on the toolbar to save the change and perform the
cutout test on cylinder number 1.

When finished, always remember to return the Cylinder Cut Out Test Enable to Disabled, and
return the cylinder being tested to 1 (enabled). Use the Save button on the toolbar to save the
change.
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FIGURE 59. SINGLE CYLINDER CUTOUT TEST
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6 Initial Calibration for Consumer
Products

6.1 About Initial Calibration
The Initial Calibration feature is used to download a calibration file into a corrupt control that will
not respond to an Update Calibration. An Update Calibration should be used whenever possible.
Initial Calibration should be used as a recovery method only. This section covers the procedures
for performing an Initial Calibration for consumer products.

Starting with version 5.5, InPower calibration files for commercial and consumer controllers can
be downloaded from the CPG InCal website.

6.2 Initial Calibration
Use of a Capture File can reduce the amount of adjustment that may be required when
replacing the base board. If the old base board is operational, and a capture file has not already
been created, correct any active faults (if possible).

Connect the interface wiring harness from the service PC to the device.

Connect to the port by double clicking on the port that matches the COM port on the service PC
being used for the genset connection (COM1, COM2, etc.) or the Site Setup. The available
COM ports are displayed in the Device Explorer directory (left pane).

NOTE: Initial Calibration and Update Calibration are only available with a physical
connection type (MON protocol). Calibration is not available via MONnet or
through network site connections.

Select the device by clicking on it (Figure 60).

After connecting to the device, click on the Device menu and click on Initial Calibration
(Figure 61).

InCal calibration files are available at http://www.cumminspower.com.

Refer to the genset engine label for the calibration part number (Figure 62). The model family is
needed to select the correct calibration.

If a pop-up message is displayed, indicating that there is an error loading INCAL, the disk drive
letter was not correctly specified during InPower installation. Click on Yes, and specify the
correct CD drive designation.
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FIGURE 60. MAIN WINDOW

FIGURE 61. MAIN WINDOW
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FIGURE 62. GENSET DATAPLATE AND CALIBRATION LABEL

The INCAL CD location can be verified by clicking on the Port menu and clicking on Find
INCAL (Figure 63). Select INCAL CD drive designation from the drop-down list, then click on
Verify INCAL Structure. A pop-up message will verify the INCAL location (Figure 64).

FIGURE 63. FIND INCAL
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FIGURE 64. INCAL LOCATION FOUND

6.2.1 Selecting Calibration Part Number
The Select Calibration window (Figure 65). lists all of the calibration files that are available from
the Power Generation INCAL CD.

Use the scroll bar to locate the Calibration model that matches the model shown on the genset
engine label (Figure 62).

The data, displayed in each column, can be sorted in ascending or descending order by clicking
on the column heading.

Click on the matching calibration part number to select it. When the matching calibration part
number for the genset model is selected, click on Next, to continue the Initial Calibration.

6.2.2 History
The History window is displayed when the NEXT button is selected (Figure 66). This feature
displays the calibration file Revision History, Calibration File (part number) and Revision
Description.

If this window displays a calibration file that does not match the model listed on the genset
engine label, click on the Back button to choose the correct calibration file.

If History displays the calibration file part number that was previously selected, click on the Next
button to proceed to the Save and Restore Parameters feature.
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FIGURE 65. SELECT CALIBRATION

FIGURE 66. HISTORY

6.2.3 Save and Restore Parameters
The Save and Restore Parameters window displays the Parameter Descriptions, Values, and
Units of measure information (Figure 68).

6.2.4 Use Capture File Feature
From the Save and Restore Parameters window, click on the Set Data Plate From Capture
File button to select the capture file created from the previous control (if available).
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If using the Set Data Plate From Capture File button, browse to the Capture file location and
select the file, then click on the OK button (Figure 67). Using a capture file, during an initial
calibration, will only restore the dataplate information. To restore the remaining capture file
parameter settings, click on the box next to the Overlay Capture File After Calibration. If this
feature is not used, the capture file can still be used after performing the initial calibration to
overwrite the parameter settings. This is not recommended because user data will be cleared
during the download.

FIGURE 67. SELECTING A CAPTURE FILE

The Save and Restore window will display the capture file name selected (Figure 69).

Verify that the information displayed in the parameter list matches the information shown on the
genset, alternator and engine data tags. Use the scroll bar to review all of the information. If any
information needs to be corrected, double click on the data and enter the correct information.

After confirming that the correct information is displayed in the parameter list, click on the Next
button.

FIGURE 68. SAVE AND RESTORE PARAMETERS
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FIGURE 69. CAPTURE FILE SELECTED

6.2.5 Calibration Download
The calibration file download may take a few minutes or longer, depending on the service PC
and the communication port.

When the download is complete, a final pop-up message informs the user if the download
completed successfully. If the download completed successfully, click on the OK button to close
the pop-up message. (Figure 70).

If the pop-up message indicates that the download was not successful, repeat the Initial
Calibration procedure. If the download is still not successful, record the error message and
contact service for help.

FIGURE 70. FEATURE LIST

6.3 Writing Adjustments From a Capture File
If a capture file was made prior to the control being replaced, and the Overlay Capture File
After Calibration feature was not used, the capture file can still used after performing the initial
calibration. The previous parameter adjustments and settings, stored in the capture file, can be
written to the new control (device).
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NOTE: Read only information cannot be written to when overlaying a capture file.

6.4 Final Adjustments
Prepare to start the genset and test the operation of the entire system. Refer to the genset
service manual for adjustment procedures and observe all safety precautions described in the
genset service manual.

After completing all necessary adjustments, make a new capture file. Store a copy of the
capture file at the site and return a copy to Service for cataloging.
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Products

7.1 About Update Calibration
The Update Calibration feature is used to replace a current calibration file with a newer version
from the Power Generation INCAL web site. The new calibration file is written over the current
calibration file in the genset baseboard. This section covers the procedures for performing
Update Calibration for consumer products.

NOTE: Initial Calibration and Update Calibration are only available with a physical
connection type (MON protocol).

Starting with version 5.5, InPower calibration files for commercial and consumer controllers can
be downloaded from the InCal CD or from the CPG InCal website.

Calibration updates are performed at the site, using InPower. This section describes the
procedures for performing Update Calibration.

NOTE: InPower calibration fails if the InCal CD is being accessed from a shared
drive.

7.2 Update Calibration
After connecting to the device, click on the Device menu and click on Update Calibration
(Figure 71).

If prompted with the message, “Could not find a matching Calibration Part Number ...," click on
the OK button. Use the Initial Calibration feature to update the calibration file.

After selecting Update Calibration, the History window is displayed.

FIGURE 71. UPDATE - DEVICE MENU
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FIGURE 72. HISTORY

7.2.1 History
The History window displays information about the currently installed calibration part number
and calibration revision across the top of the window (Figure 72).

The History window also displays information, from the Power Generation INCAL CD, about the
Revision History, Calibration File part number and Revision Description.

The Save and Restore checkbox is used to save the current adjustment trims and settings.
Make sure the checkbox is enabled (checked) before proceeding.

Click on the Finish button to proceed with the calibration update.

The message “Do you wish to calibrate the controller now?" is displayed. (Figure 73). Click on
the Yes button to continue.

NOTE: Pop-up messages may be displayed behind an open window. To view all
open windows, including pop-up messages, hold down the Alt key and
repeatedly press the Tab key to view each open window.

FIGURE 73. UPDATE NOW

When the download is complete, a popup message informs the user if the download completed
successfully (Figure 74). Click on the OK button to acknowledge.
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FIGURE 74. COMPLETED
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8 Monitor
This section describes how to use the Monitor and Datalog features. There are two methods of
monitoring parameters, the user can create a custom Monitor dialog for viewing selected
parameters, or the user can view pre-selected parameters, based on the device type.

8.1 Monitor and Datalog
The Monitor and Datalog features are used to view and record (datalog) parameters. The user
can monitor preselected parameters with Device Explorer, or they can select the specific
parameters they want to monitor and record, using the Monitor Dialog feature.

InPower's Device Explorer allows the user to navigate and view preselected parameters.

8.2 Monitor Dialog
The Monitor Dialog allows the user to select the parameters they want to view, set a sampling
rate and enable the data logging feature. Sampling allows realtime data viewing. Data logging
stores information in a file for later use.

The Monitor Dialog is displayed when the Monitor command is launched from either the Start
menu or the Monitor button, on the InPower toolbar.

8.2.1 Monitor Dialog Features
The Monitor Dialog is shown in Figure 75. This section describes how to use the Monitor Dialog
features.

File Menu: Used to create a New Monitor file or to Open an existing Monitor file. Also used to
Save changes to an opened file or Save As..., to save changes to a new file. Recent allows the
user to view recently opened files and is used as a shortcut to open a file.
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FIGURE 75. MONITOR DIALOG FEATURES

Edit Menu: Use the Edit menu commands to Add, Delete, Edit, Cut, Copy, Paste, and Save
Adjustment parameters into and out of the Monitor Dialog.

View Menu: Use the View command to hide or display the Toolbar and Status Bar.

Help Menu: Provides InPower Help Topics and About Monitor help.

Sampling: The Monitor dialog will sample at the selected setting. To select the sample rate,
click on the Sampling - Enabled check box (enabled when checked). Enabling the Sampling
feature activates the Sampling Rate list box. Select the desired sampling rate from the list box.
Sample rates are available from 0.05 seconds to 60 seconds.

Logging: Logging al lows the user to log parameter information to a .LOG file (at the selected
Sampling Rate). Sampling must be enabled to use this feature. Before enabling data logging,
enter a name in the file dialog. The log file uses the tab delimited file format. To select the
Logging feature, click on the Start Logging button. When data logging begins, the button text
switches from Start Logging to Stop Logging. Click on the Stop Logging button to stop data
logging.

Data can be logged to the default (Monitor_<Time Stamp>.001.log) file where the time stamp is
"MM_DD_YYYY_HH_MM_SS" (for example, Monitor_12_22_2011_13_46_10.001.log). If this
file exceeds the size limit of 4 MB, a new file is created where the last digits that were 001 are
incremented to 002 (for example, Monitor_12_22_2011_13_46_10.002.log).

A report can be generated if you click on the Generate Report button. The Browse button
allows the user to locate and overwrite a .log file in another directory.

A report can be generated if you click the Generate Report button. The Browse button allows
the user to locate and overwrite a .log file in another directory. The Monitor utility displays
reports correctly when parameters from multiple sites are being logged.
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NOTE: If the list of variables is long, the actual log rate may be longer than the
selected rate.

If logging is stopped and started again, the message shown below is displayed.

FIGURE 76. LOG FILE ALREADY EXISTS MESSAGE

Three buttons are available.

· Click the OVERWRITE button if the existing log file is to be overwritten.

NOTE: Because all previously saved data will be erased, overwriting an existing file
is not advisable.

If the OVERWRITE button is selected, the following message is displayed to remind the
operator that using this feature will result in the existing file being overwritten. Click Yes to
overwrite the existing log. If No is selected, the message shown above will be redisplayed.

FIGURE 77. OVERWRITE CONFIGURATION MESSAGE

· Click the APPEND button if the existing log file is to be appended with the new data logs.

· Click the CREATE NEW LOG FILE button if the data logging is to be continued in a new
log file.
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8.2.2 Adding Parameters
Parameters can be added to the Monitor Dialog by selecting Edit - Add from the Menu bar or
by clicking on the Add button, on the toolbar. The Add command launches InPower. Use
Device Explorer to locate, select and copy the parameters that you want to add to the Monitor
dialog.

After selecting a parameter, use the drag-and-drop procedure to add the parameter to the
Monitor Dialog. (Or use the right menu button to Copy it, then move the cursor to the Monitor
Dialog and use the right menu button again to Paste the parameter into the Monitor Dialog.)

Monitor settings can be saved to a template (.TPL file). These files are saved in the Monitor
subdirectory of InPower. The template file stores the COM port information, this prevents the file
from working on another COM port.

Each monitor screen provides the ability to log sampled values into a tab delimited .LOG file.
This file format allows the data to be imported into Microsoft Excel.

8.2.3 Saving Parameters
Parameters values can be edited and saved in the controller flash memory from monitor utility.

1. To edit the parameter from monitor utility, double click on parameter or select the
parameter from monitor and go to menu Edit->Edit. The Change/Write dialog is launched.

FIGURE 78. CHANGE/WRITE ELEMENT DIALOG

2. After changing the value click on Change button. After clicking on Change button, The
Change/Write dialog closes and the monitor shows the changed parameter row in blue.
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FIGURE 79. CHANGED VALUE SHOWN IN BLUE

3. To launch the save adjustment dialog from the monitor utility, select menu items Edit-
>Save Adjustment or click on the save adjustment icon on the tool bar.

FIGURE 80. SAVE ADJUSTMENT MENU ITEM
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FIGURE 81. SAVE ADJUSTMENT TOOL BAR ICON

4. If one or more parameters are present in the save adjustment list. The Save adjustments
dialog is launched. The Save adjustment functionality is only supported by applications the
"Device explorer", "Monitor utility" and "Snapshot Configuration".

FIGURE 82.
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9 Faults and the Fault Information
System
This section describes the fault information features available for various types of devices.

9.1 Consumer Device Fault Information
Three categories of fault information are available with RV gensets: Advanced Fault Info, Fault
History, and Fault Occurrences. Marine gensets include the same three categories of fault
information plus an additional category, Fault Bypass Info.

The Fault Information Window displays detailed information for each of the parameters listed
in each category.

9.1.1 Fault Information
Use the InPower Device Explorer to view Faults for a connected device. Current fault
information for a device is only available when you are connected to the device.

To access the Fault Information Window, start InPower and connect to a port, then connect to
a device. To view the fault categories, select the device name and either expand the device
directory or else click on the View Faults shortcut button (Figure 83).

Each fault is represented by a fault code indicating a particular malfunction or abnormal
condition within the device.

FIGURE 83. FAULT INFORMATION WINDOW FOR RV GENSET

9.1.2 Advanced Fault Information
The Advanced Fault Information window (Figure 84) is for factory use only. This window shows
the number of faults enabled in the software. For some gensets, it also shows the number of
fuel faults enabled in the software.
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NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.

9.1.3 Fault History
The Fault History window (Figure 84) lists all active fault codes for a connected device and the
last recorded faults that occurred (some display the last five faults).

To find information about fault codes and how to correct faults, refer to the Fault Help menu.
Use this information to match a specific fault to the symptoms observed by the operator. This
information can help you determine which fault to address first.

NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.

FIGURE 84. ADVANCED FAULT INFORMATION

FIGURE 85. FAULT HISTORY
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9.1.4 Fault Occurrences
The Fault Occurrences window (Figure 86) lists all possible faults that are available with the
device and the number of times each fault occurred.

NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.

9.1.5 Fault Bypass Info
Fault Bypass Information (Figure 87) is only available with Marine MDDCx gensets. This screen
displays the number of minutes the control was operated in fault bypass mode and other events
that may have occurred while in fault bypass mode. If any of these events occur, a number is
placed in the Value column.

FIGURE 86. FAULT OCCURRENCES
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FIGURE 87. FAULT BYPASS INFORMATION (FOR SELECT MARINE GENSETS ONLY)

9.1.6 Clearing Inactive Faults
InPower does not allow removal of an individual inactive fault. The Clear Faults button is
disabled.

To clear faults, press the Stop or Start switch on the genset, as described in the genset
Operator's Manual.

9.1.7 Consumer Device Fault Information
Consumer Device Fault information is available from the Help menu (Figure 88). It includes a
list of possible faults that can occur with each genset model. Each individual fault includes a
fault description, a list of possible causes, and diagnosis and repair procedures.
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FIGURE 88. CONSUMER DEVICE FAULT INFORMATION HELP FILES
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10 Event Handler

10.1 Receiving Events
When connected to a device, InPower will receive events, and allow the user to acknowledge
events.

It is important to note that InPower is a service tool. InPower will receive and display events, but
it does not acknowledge events within the device. Monitoring should be performed with
operating software that is specifically designed for monitoring and event acknowledgment.

The Event Handler feature launches when InPower is started, and it closes when the InPower
session is ended.

Events are displayed in the Alarm dialog until InPower is closed, or the user clears
(acknowledges) the events. The record of event announcements is not stored from one session
of InPower to the next.

Acknowledging events removes the events displayed to the InPower user only.
Acknowledgement with InPower will not remove the event from the control.

InPower displays an Alarms popup dialog to view event information as soon as the event is
received. Users can clear events, view more information about an event, or simply close the
Alarm popup until the next time the device announces an event.

Be aware that event announcement and fault code diagnostics are not the same function.
InPower provides fault code and diagnostic information that is not related to event
announcement.

10.2 Displaying Events
InPower will display all events that have been received in an Alarm dialog. When the Auto-
Announce feature is enabled (default setting), the Alarm dialog pops up to displays of all the
events it contains. Additional details about the events are available in the Event Detail dialog.

10.2.1 Alarms Popup
The Alarm Popup provides details about events. The Alarms popup dialog menu features can
be used to view more details about an event, clear the event, or dock the Alarm Pop-up back to
the Windows taskbar. To launch the Alarms pop-up from the taskbar, click on the Alarms
button.

The Alarm Popup provides the following menu bar and button options.

View-Acknowledge All: Selects all displayed alarms and removes them from the Event popup
view.

View-Detail: Displays the Event Details dialog of the selected event.

Options-AutoAnnounce: Displays a check box for displaying the Alarms Popup. If checked,
(default setting) the Alarms popup displays each time a new event is received. If unchecked,
the Alarms Popup will not open automatically to announce new events.

Help-Contents: Displays InPower help contents.
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Help-Search: Used to searching for an InPower help topic.

Close Button: Used to dock the Alarms popup dialog to the Windows task bar.

Help Button: Used to access Event Announcement help.

The most recent event is added at the top of the list. One event will always be selected
(highlighted). Events received while the Alarm dialog is displayed will appear in the dialog
immediately.

10.2.1.1 Columns in the Alarms Popup
The Alarms popup provides the following columns:

Code: This displays the fault code associated with the event.

Description: This displays a textual description associated with the event. The description
comes from the controller.

Level: This indicates the type of event that occurred; for example, shutdown, warning, or none.
If this is not applicable to the controller (for example, a G-drive controller), the value is "None".

Status: This indicates whether the associated fault code became active or inactive in this event.

Site:

Module: This displays the type of device that reported the event.

Time: This displays the time at which the event occurred.

10.2.2 Event Detail
Events have additional detail associated with them. The user can view these details in the
Event Details dialog by selecting an event, then selecting View-Detail from the View menu.

The Event Details dialog provides the following button options:

Close Button: Closes the Event Details dialog and returns the user to the Alarms dialog.

Navigation Buttons: The left arrow button changes the Event Details dialog to display the next
event (down) on the Alarm dialog list. The right arrow changes the Event Detail dialog to display
the previous event (up) on the Alarm dialog list.

Help Button: Used to access Event Details help.

10.2.2.1 Columns in the Event Details Dialog
The Event Details dialog provides the following fields:

In the Alarms section,

Description: This displays a textual description associated with the event. The description
comes from the controller.

Status: This indicates whether the associated fault code became active or inactive in this event.

Level: This indicates the type of event that occurred; for example, shutdown, warning, or none.
If this is not applicable to the controller (for example, a G-drive controller), the value is "None".

Code: This displays the fault code associated with the event.

Version:

Occurrences: This displays the number of times the event has occurred.
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Last Occurrence: This field is blank.

Run Time Last: This displays the most recent time the event occurred.

First Occurrence: This field is blank.

Run Time First: This displays the first time the event occurred.

In the Module section,

Type: This displays the type of device that reported the event.

Address: This displays the network address of the device that reported the event.

In the Site section,

Site Id: This displays the name of the site; typically, the name of the COM port for devices or
the file name type for files, such as capture files.
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11 Strip Chart

11.1 Strip Chart
The Strip Chart feature displays data in a graphical form on a real-time strip chart. Up to six
parameters can be displayed in one chart. Data is scrolled from right to left, so the most recent
data appears at the right.

Chart parameters can be saved to chart file (.TPL file), allowing the user to save custom
parameter selections and settings. The chart file will store the charts graph settings (Y-axis
limits, sampling rate, line styles, etc.) and port identification. A chart file can be used with other
ports. Chart files are saved in the Strip Charts directory.

Data is not logged using the Strip Chart feature, in contrast to the Monitor feature.

11.1.1 Example of a Strip Chart

FIGURE 89. TYPICAL STRIP CHART

This example shows a typical strip chart. Each of the parameters contained in the chart are
named in the legend at the top of the chart. The Y-Axis displays the range of each parameter
value. The Time that the sample was taken for each interval is displayed at the bottom of the
chart.

11.1.2 Starting the Strip Chart Feature
The Strip Chart feature can be launched in two ways:

1. Launch strip chart from the Start Menu group shortcut.

2. Start InPower, connect to a device, and then click on the Strip Chart button, on the
InPower toolbar.

Starting a strip chart from InPower, while connected to a device, allows InPower to identify the
device and display the correct strip chart file type. This prevents accidentally opening a strip
chart file for the wrong device type.
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If the chart file does not exist, Strip Chart will display the File-Open screen, with a listing of
chart files in the Strip Charts directory.

11.2 Creating a Custom Strip Chart
Strip charts can be customized by adding or deleting parameters, adjusting the sampling rate,
changing line styles, changing the Y-axis limits and making format changes.

The user can customize an existing strip chart, or create a new strip chart and define each of its
properties. To create a new strip chart, launch the Strip Chart feature from the Start -> All
Programs menu, without specifying any chart file to open.

FIGURE 90. TYPICAL STRIP CHART

11.2.1 Adding Parameters
Click on Add Parameters, from the Edit menu, to launch InPower. To add parameters to the
strip chart, drag individual parameters from InPower (right pane) and drop the parameter on the
strip chart. Multiple parameter selections may be dragged and dropped on the Strip Chart, to
add several parameters at once. Parameters can also be added by selecting a parameter and
using the Edit - Copy command from InPower and the Edit - Paste command from the Strip
Chart menu bar.

Since parameters with different units of measure may be added to the graph, a separate Y-axis
will be displayed for each graphed parameter.

As parameters are added to the graph, an additional Y-axis will appear, indicating the
parameter's description and unit of measure. A new legend item will appear at the top of the
graph, indicating the point shape and color that will be used when plotting the parameter's
values, and these values will automatically begin to be displayed.

Immediately after the first parameter is added to the Strip Chart graph, the applet automatically
begins monitoring parameter values at half-second intervals. The sampling rate may be
modified via the Options dialog.
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11.2.2 Parameter Properties Dialog
The Parameter Properties dialog, shown in Figure 91, is accessible from the Edit-Properties
menu.

The Name combo box, at the top of the dialog, provides access to each of the parameters
currently displayed on the Strip Chart. The user may delete the selected parameter from the
strip chart by clicking on the Delete button.

The Data Ranges associated with the selected parameter may be modified by entering new
values into the edit boxes. These new values will control the minimum and maximum data
values displayed on the Y-axis of the graph.

The Line Attributes may also be modified by selecting a new line style from the Style combo
box. A new line color may be selected by clicking on the Color button, which invokes the
Windows common Color dialog. Current changes are applied after the user clicks on the OK
button, to close the dialog.

FIGURE 91. PARAMETER PROPERTIES

11.2.3 Sampling Rate Dialog
The Sampling rate feature is available from the Strip Chart - Options menu. The Sampling
Rate dialog, shown in Figure 92, allows the user to select the strip chart sampling rate.
Sampling can be enabled or disabled using the Sampling Enable feature (see Strip Chart
Menu Bar Functions).

FIGURE 92. SAMPLING RATE DIALOG

When finished customizing the strip chart, choose the File-Save As... menu option. Name the
file and save in the Strip Charts directory.
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NOTE: Saving a Custom Strip Chart saves only the chart settings, it does not save
(log) data.

See Context Menu for additional commands that are available for customizing strip charts.

11.2.4 Strip Chart Menu Bar Functions
This section describes each of the menu commands that are available from the Strip Chart
menu bar.

File-Open: Allows the user to specify a particular chart (.TPL) file to load from the list of chart
files, in the Strip Chart directory. Logged data (.LOG file) can also be opened and viewed with
the Strip Chart feature.

After a .TPL file has been selected, the applet will open the file and load the parameters and
settings from that file. Since parameter values will be graphed, only the first six parameters that
have numeric values will be accepted.

File- Save: Allows saving the current selection of parameters to a chart file.

File - Save As: Allows saving the current set of parameters to a new chart file name and/or
location.

File-Close: Closes the Strip Chart

Edit-Add Parameter: Allows adding parameters to the Strip Chart graph from InPower. This
command opens InPower, allowing the user to select parameters to be added to the Strip Chart.
Drag individual parameters from InPower and drop the parameter on the Strip Chart graph.

Edit-Paste: Allows pasting the parameter(s) from the Windows clipboard into the strip chart.
The Paste menu option will remain disabled until one or more parameters have been cut or
copied to the Windows Clipboard.

Edit-Properties: Opens the Element Properties dialog. (This feature can also be activated by
double clicking on the parameter names in the strip chart's legend.) The Element Properties
dialog allows the user to perform a variety of commands relating to the display properties of the
Strip Chart.

Options-Sampling: This option displays the Sampling Rate dialog, which allows the user to
change the strip chart sampling rate. The sample rate is adjustable from 0.05 seconds to 60
seconds.

Options-Sampling Enable: This option is used to enable or disable the collection of sample
data. A check mark is displayed next to Sampling Enable on the Options drop down menu to
indicate that the feature is enabled. Click once on Sampling Enable to stop collecting sample
data. Click on it again to start collecting sample data again.

Options-Logging: This option provides you with a means to assign a location for storing strip
log files. The default file location is listed on the menu (Figure 93). If necessary, select the
Browse button to select another location. Logging can be enabled from this menu. When all
adjustments are completed, click on the OK button.
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FIGURE 93. LOGGING DIALOG

Options-Logging Enabled: This option is used to enable the logging option to save a file at the
location set up with the Logging dialog. If a strip chart log has already been created, the
message shown in Figure 94 is displayed.

FIGURE 94. LOGGING MESSAGE

11.2.5 Context Menu Features
The Context Menu, shown in Figure 95, may be accessed by clicking on the right mouse
button (or equivalent pointing device button) while the cursor is inside the graph. This set of
menu items provides the users with additional customization features.

FIGURE 95. CONTEXT MENU FEATURES (RIGHT MENU BUTTON)

Viewing Style: This controls the viewing style of the object. Possible values include color,
monochrome, or monochrome with symbols.
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Font Size: This controls the font size used in the graph's image creation process. The font sizes
available are large, medium, or small.

NOTE: It is recommended that the user change the Font Size to the Medium setting
or Large setting if only a few parameters are being monitored. This selection
will make it easier to read the parameter legends.

Numeric Precision: This controls the number of decimal places associated with the graph's
data. Possible values include zero, one, two or three decimal places.

Data Shadows: This controls whether shadows will be placed behind plotting method graphics.
The shadows add depth to the images; however, they will slow image creation significantly
when graphing many subsets and/or points.

Grid Lines: This controls the horizontal and vertical lines that make up the graphs grid.
Possible values include horizontal and vertical grid lines, horizontal grid lines only, vertical grid
lines only, or no grid lines.

Grid In Front: This controls whether the graphs grid is placed behind or in front of the plotting
method graphics.

Graph and/or Table: This controls what is displayed in the graph's area. Possible values
include graph, table, or graph with table.

What to Table: This controls what information is included in the objects table. Possible values
include tabling those subsets that are graphed or tabling all subsets.

Point Label Orientation: This controls the orientation of the point labels. Possible values
include automatic, horizontal, or vertical.

Mark Data Points: This controls whether data-points are marked with a small circle.

Maximize: This function maximizes the graph display. To return to the default display size, click
inside the solid bar at the top of the window or use the Esc key.

Customization Dialog: This function displays the chart Customization dialog.

Export Dialog: Graphs can be exported in the formats shown in Table 4, for the listed
destinations. This dialog allows the user to print a Strip Chart.

TABLE 4. GRAPH EXPORTABLE FORMATS

FORMAT DESTINATIONS

Metafile Clipboard, File, and Printer

Bitmap Clipboard and File

OLE Object Clipboard

Text / Data Clipboard and File

Help: Displays graph-related help topics.

11.2.6 Chart Customization Dialog
An additional level of editing is available that allows the user to customize the chart dialog. To
access this feature, double click within the chart to display the Customization dialog. This
dialog has tabs for each of the editable features.
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Click on the desired tab to view the available settings for that feature. These features can be
used to enhance the chart by changing border colors, text size and colors, and many other chart
display features.

FIGURE 96. CHART CUSTOMIZATION DIALOG

11.2.7 Printing a Strip Chart
A Strip Chart can be printed by using the Export dialog (Figure 97). Use the right menu button
to access the Export Dialog, then select the Printer radio button and select the Print button.

FIGURE 97. EXPORT - PRINT DIALOG

11.2.8 Viewing Logged Data
Logged data, created with the Monitor feature can be displayed with the Strip Chart feature.
Select Open from the Strip Chart File menu. Enter the .LOG file location and name.

Strip Chart will display the logged data. Since the data is not being displayed on a realtime
basis, the data is static. Use the left and right arrow buttons located on the keyboard to navigate
the data within the .LOG file.

901-0112 (Issue 11) 93



11. Strip Chart 11-2013

This page is intentionally blank.

94 901-0112 (Issue 11)



12 Capture File

12.1 Capture File
InPower provides a method of extracting (capturing) a device's parameter values. Capturing
saves device information in a file that is identified with a .CAP extension. The files are saved in
the Capture Files directory.

Capture files are used to store a copy of a device's parameter values, History and Faults.
Capture files are read only files that can be viewed after disconnecting from the device. Capture
files can also be used as a template to write the captured settings to another device of the same
type.

12.2 Creating a Capture File
Capture files can be created by selecting the Capture to File command from the Device menu.
This feature displays the Capture File dialog, which is similar to Save As dialog.

The user names the file, and InPower appends the file name with the .CAP extension. Capture
files are not editable by InPower (read-only). A capture file can be overwritten, allowing the user
to re-capture parameters and settings to the same file.

12.2.1 Creating a Capture File Automatically
A Capture files will be automatically captured each time you connect to a site or you will be
prompted to create one, depending on your setup selection.

If Capture to File is selected, a default filename will be created. This filename can be changed.

12.3 Viewing a Capture File
To view a capture file, the user must connect to it using InPower. Double click on the Capture
file name in the Capture Files directory structure. Capture file contents can be viewed, like
devices, using Device Explorer.

In InPower, the capture file is compared with support files. If a parameter is found in Support
files but not found in the capture file, the tool will give a warning message. If parameters which
are not supported in the firmware are removed from Support file, the capture file will get
connected without showing any warning message.
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FIGURE 98. VIEW CAPTURE FILE WARNING MESSAGE

12.4 Writing to a Device
Capture files can be used to overwrite the parameter values of a connected device (of the same
device type) with the parameter values from a capture file. One capture file can be used
repeatedly (like a template) to configure many devices of the same type.

When a device has password protected parameters, the password protection applies when
writing a Capture file to the device. The user must enter the required password(s) before the
password protected parameters can be changed with the Capture file.

To write to a device you must have registered software of the correct device type.

To write from a Capture file, connect to the Capture file first, then click on the target device, and
connect to it. Next, select the Capture file and drag-and-drop the Capture file onto the target
device.

The Edit - Copy and Edit - Paste features can also be used to write parameter settings from a
Capture file to a device. This feature can be used to copy the entire Capture file, or individual
folders or parameters.

Start by connecting to the Capture file, Use Edit - Copy to copy the desired information from
the Capture file. When copying a folder or individual parameters, use Device explorer to display
the desired folder or parameters in the right pane. Hold down the Control key while selecting the
desired folder (s) or parameter(s) then use the Edit - Copy command. Connect to the target
device and use the Edit - Paste feature to overwrite the target device's parameters with the
parameter settings from the Capture file.

NOTE: A capture file from a genset (for example) can be copied to another genset,
but it cannot be copied to a transfer switch control, or any other device type.
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13 Simulator
InPower provides a means of demonstrating the service tool without connecting to an actual
device. A Capture file is used for simulation. This file contains most of the information that is
normally displayed when you are connected to a device.

Any capture file(s) used for simulation are added during InPower installation. These files are
device specific, for example, if you install a genset InPower product, you will only receive genset
Simulator files.

Simulator files are read only, although during simulation, the user will be allowed to make
editorial changes, to help demonstrate the tool. Any changes made during simulation will not be
saved.

If an arrow is displayed, click on the arrow to view a drop-down list of the available settings.
Click on the desired setting, and it will be entered into the Value cell.

The simulator file(s) are stored in the Simulator directory. To run an InPower simulation, double
click on the Simulator directory and then double click on the desired simulator file (*.CAP file).
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14 Reports
This section describes how to create, save and print reports. Reports consist of parameter
groups and their values at the time the report was created. Reports can be printed directly from
InPower, or they can be saved to a file for use in a spreadsheet, database, or word processing
program.

14.1 Creating a Report
Start InPower and connect to a port, then connect to a device (or file). Use the Device Explorer
(tree view) to locate and select the information you wish to include in the report.

NOTE: When selecting parameters for a report, be careful to avoid selecting too
many parameters. If a folder is selected that contains additional folders, the
parameters of all of the folders in the group will be selected.

You can create a report from a single group of parameters or from several groups of
parameters. A few smaller reports are generally more manageable than a very large report.

To create a report for a single group of parameters: Select the group folder, if it contains
additional folders, double click on the folder to expand it. Select the desired folder and use the
mouse or keyboard menu button to display the pop-up menu (Figure 99). Select Print Feature
from the pop-up menu, to create a report for the selected folder and display the Parameter List
Report window (Figure 100).

To create a report with more than one group of parameters: Select each folder individually,
use the mouse or keyboard menu button to display the popup menu, click on Select Feature, in
the popup menu. Each folder selected will be marked with a check mark, to indicate that it has
been selected for use in the report (Figure 99).

After selecting the desired parameter groups, use the Prepare CSV file with all Selected
Features menu pick from the InPower Device menu to create a report and display the
Parameter List Report window (Figure 100).

NOTE: If you only want to create a report on one feature, select the feature, right-
click and select the Prepare CSV file for Feature menu pick.

Selected folders can be deselected by clicking on a folder with a check mark, then use the
mouse or keyboard menu button to display the pop-up menu, click on Deselect Feature, in the
pop-up menu.

The Parameter List Report window allows viewing the report contents. Each selected
parameter group is shown.
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FIGURE 99. SELECTING FEATURES FOR A REPORT

FIGURE 100. PARAMETER LIST REPORT WINDOW

14.2 Support Reports
A Support Report can be created and Emailed.

To create a Support Report,

1. Select Help > Send Support Report.
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FIGURE 101. LAUNCHING THE SEND SUPPORT REPORT FEATURE

2. When the ETools Support Report Utility dialog is displayed, enter an Issue Title and
Issue Description.

FIGURE 102. ETOOLS SUPPORT REPORT UTILITY DIALOG
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If these fields are not filled in, the following error message is displayed when attempting to
save the report.

FIGURE 103. ERROR REPORT UTILITY MESSAGE

3. Click Save Report. The following message is displayed. Click OK.

FIGURE 104. SAVED REPORT MESSAGE

4. If you wish to attach additional files, click Attach File. Navigate to the location the file is
stored, select it, and click OK. The total attachment size cannot exceed 2MB. If this limit is
exceeded, the following message is displayed.

FIGURE 105. ATTACHMENT SIZE EXCEEDED MESSAGE

NOTE: A file can also be removed by using the Remove Attachment button.

If, after creating a Report, you wish to Email it,

1. Click Email Report on the ETools Support Report Utility dialog box. The report is saved in
ZIP format at the default location.
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2. Once the Report is saved, an Email message with the default mailbox location for
Cummins InPower support is displayed. Click Send.

FIGURE 106. EMAIL FOR ERROR REPORT

If you wish to view an existing report, click Open Report Folder on the Error Report Utility
dialog box. The default error report location (D:\Program Files\Power
Generation\Shared\Reports) is displayed.

FIGURE 107. ERROR REPORT DEFAULT LOCATION
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15 Event Configuration
This section describes how to use the Events Configuration feature. This feature is only used
with genset applications. Event Configuration allows the InPower user to configure both the
Fault Effect and the Notification settings for Faults.

The term events refers to status changes that can be viewed on a control display or with
InPower. There are two types of events, fault events and non-fault events. The Event
Configuration feature is used to configure fault events (Faults). Faults represent genset
operating conditions that are outside the normal operating range or setting.

Start InPower and connect to the port (COM1, COM2, etc.) being used for connection to the
device.

Click on the Events Configuration folder to view the Events Configuration parameters (Figure
108). This group displays all of the genset Faults numerically, by Fault Code. Also displayed are
the Fault Descriptions, current Fault Effect settings and current Notification settings.

15.1 Fault Effect
Fault Effect is used to configure the action taken when a fault becomes active. All faults are
pre-configured with a fault effect.

The severity of the effect generally cannot be decreased. For example: Engine Overspeed
cannot be changed from Shutdown to Warning.

In genset applications, there are five possible Fault Effect settings.

None: When a Fault Effect is set to None, there is no effect when the fault becomes active
(including no dialout notification).

Warning: A warning message is delivered to the control display and to InPower when InPower
is connected to the device.

Derate: Faults configured for Derate will act like a Warning when the fault is active. If a
parameter has a factory set derate percentage the genset will derate to that setting when the
fault is active.

Shutdown: Faults configured for Shutdown will cause the genset to shutdown immediately
when the fault is active.

Shutdown Cooldown: Faults configured for Shutdown Cooldown will shed the load (if
available) and shut the genset down after a cooldown period, when the fault is active.

To change the effect of a fault, double click on the Fault Effects value cell, for the desired fault.
A drop-down arrow will be displayed. Click on the drop-down arrow to display the setting
choices (Figure 108). Click on the desired effect, to select it.. Click on the Save Trims button,
on the toolbar, to write the new value to the device.
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FIGURE 108. FAULT EFFECT

15.2 Notification
Notification refers to annunciation of the fault for remote monitoring. In order to remotely monitor
genset faults, the Fault Notification setting must to set to Dial Out.

There are two possible settings for Notification as follows:

Don't Dial Out: When Notification is set to Don't Dial Out, the control will not attempt to dial out
when the fault becomes active.

Dial Out: When Notification is set to Dial Out, and remote site(s) are configured, the control will
attempt to dial out to annunciate the fault to one or more remote locations. The modem must be
enabled, a valid dialout number must be entered, and the fault Effect must not be set to None.

To change the Notification setting for a Fault, double click on the Notification value cell, for the
desired fault. A drop-down arrow will display, click on the drop-down arrow to display the setting
choices (Figure 109). Click on the desired effect, to select it. Click on the Save Trims button,
on the toolbar, to write the new value to the device.

FIGURE 109. NOTIFICATION
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16 Help
Use the Help menu to find information about using InPower, to find Service and Support
information, and to find out about the installed InPower product type and software version.

16.1 Search for Help On...
The Help - Search for Help On... feature allows searching for help on a specific topic or keyword
(standard Windows Help format). Access this feature by clicking on the Help menu, then click on
Search for Help On... .

16.2 Contents
The Help - Contents feature provides access to the list of subjects in the InPower help file
(standard Windows Help format). Access this information by clicking on the Help menu and then
clicking on Contents.

16.3 How to Use Help
The Help - How to Use Help feature displays the standard Windows Help Topics dialog. Use
this feature to find answers to basic Windows operation questions. Access this information by
clicking on the Help menu, and then click on How to Use Help.

16.4 Service and Support
The Help - Service and Support feature lists information about where to call for InPower product
support. To view this information, click on the Help menu, then click on Service and Support.

16.5 About Device Explorer
The Help - About... feature initiates the About Device Explorer box. This box displays the
product type and software version. The expiration date for the software is also shown. To view
this information, click on the Help menu, and then click on About....
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17 Glossary
Applet - A sub-set of software functions that may be included in one or more Tools. They
provide the building-blocks from which the Tools are constructed.

ATS - Acronym for Automatic Transfer Switch.

Automatic Voltage Regulator (AVR) - An electronic unit used to control the output voltage of a
genset.

BIT - Acronym for Built-in Test.

Calibrating - The process of reprogramming a device. This requires the ESDN version of
InPower.

Calibration - Term used to describe the program and factory settings for a device.

Calibration Table - Name used to refer to a Data Table, XY Table, or XYZ Table that contains
one or more calibration variables.

Calibration Variable - Data that is stored in the controller's non-volatile memory, and which
may not be altered after sale by either a customer or service technician.

Capture File - A capture (.cap) file contains all of the trim values, monitor values, and table
values of a given device (e.g. Generator set). This file can be thought of as a “template” for
configuring other devices of the same type, or it can be used as a backup file.

Channel - A channel is the physical communication media that connects the devices and the
properties of these media (such as transmission speed).

CSV File - Comma Separated Value file (same as a comma delimited file). The file format used
by InPower to save datalog information. Allows the file to imported into Microsoft Excel.

Data Table - Data table is a structure containing a variable in each of the columns. The data
cells are viewed and edited in spreadsheet format.

Device - As used in InPower, refers to any one of a series of application controllers used in
Power Generation applications. These include: Generator-drive engine controllers, Genset
controllers and Automatic Transfer Switch controllers.

Electronic Control Module (ECM) - The hardware residing on an engine which carries out all
the engine management functions (e.g. timing, fueling).

Electronic Software Database & Network (ESDN) - A worldwide Cummins corporate
database of released electronic software. It provides calibration files reprogramming devices.

Genset Open Architecture Link (GOAL) - A proprietary protocol developed by PGG to support
the communications functions of Power Generation Group controls.

Graphical User Interface (GUI) - A term used to describe the way in which a user interacts
with the software program.

HBF - Acronym for High Blowby Flow.

Initial Calibration - Manually select software to download.

InPower - Name given to the Power Generation Products based service tool. This tool is similar
to INSITE in function, but it has a significantly different architecture.

MON - A communications protocol for one device connected to the service tool using RS-485
and RS-232 serial communications. All devices can communicate with the service tool.

901-0112 (Issue 11) 109



17. Glossary 11-2013

MONNet - A communications protocol for more than one device connected to the service tool
using RS-485 communications only.

Network Connection - This term is used to describe a connection using the MONNet protocol
and an RS-485 adapter.

Parameter - This term is used with InPower to refer to properties whose values determine the
behavior of a device. With InPower there are two main types of properties; trims that have a
range of numeric values, and settings that consist of a small number of predefined values such
as On or Off.

Physical Connection - This term is used to describe a connection using the MON protocol and
no RS-485 adapter.

Port - As used in InPower, it refers to the channel by which a connection can occur. Port
connections can occur with COM ports, or with Simulator or Capture files in the InPower
directory structure.

PowerCommand® Control (PCC) - A microprocessor based genset monitoring, metering and
control system with integrated AVR and engine governing.

Protocol - Protocol is a language that each node on a network knows how to speak and
interpret. The protocol is what allows devices to exchange messages with one another.

Save Trims - Term used with InPower to indicate the process of permanently storing parameter
changes to a device.

Site - The name of a connection setup (COM1, COM2, etc).

TAPI (Telephony API) - A programming interface that allows Windows client applications to
access voice services on a server. Designed to provide interoperability between PCs and
telephone equipment.

Template - 1. View template in InPower describes how to display data table information. 2.
Template can also describe the Capture (.CAP) file that contains trim values that can be used to
configure multiple-devices (e.g. genset controllers).

Tool - A set (or bundle) of software applets that are targeted at a specific customer or end-user
function.

Trim - Data that is stored in the controller's non-volatile memory, but which may be altered after
sale by either a customer or service technician.

Update Calibration - Automatically updates software, saves user information, and transfers to a
new control.

Volatile/Non-volatile Memory - The contents of volatile memory is lost following a loss of
power to the controller. Data stored in non-volatile memory is retained.
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